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Getting Started Guide

Mac mini

Look around your new Mac
Get a quick intro to the ports, connectors, accessories, and other
features of your Mac mini.

Want to get started?
After you connect a display, keyboard, and mouse or trackpad, press
the power button on the back of your Mac mini. Follow the Setup
Assistant prompts, and you’re up and running.

Stay in sync
Access your documents, photos, contacts, and more across all your
devices with iCloud. And use your Mac mini with your iOS and iPadOS
devices to make phone calls, copy and paste across devices, or create
an Instant Hotspot.

Take a tour of Mac mini

Set up your Mac mini

Use iCloud with your Mac mini
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Do more
Your Mac mini comes with built-in
apps that help you stay connected,
empower you to create, provide
hours of entertainment, and more.

Discover new features
Find out what's new in macOS
Sequoia and your included apps.

Learn what you can do with apps
on your Mac mini

New features for macOS Sequoia

help:anchor='apd07d671600'%20bookID='com.apple.machelp'
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Connect a
display
Mac mini supports
up to three external
displays, which
means you’ve got a
desktop ready to
flex in any setup.

Transfer
information
Migrate your data—
like files, contacts,
accounts, and more
—from another
computer to your
new Mac.

Common
questions
Want to learn more
about your Mac
mini? Find answers
to common
questions about
your Mac.

To explore the Mac mini Getting Started Guide, click Table of Contents
at the top of the page, or enter a word or phrase in the search field.

If you need more help, visit the .

Not all features and content are available in all countries or regions. Subscription
required for Apple TV+.

Connect a display Transfer your data Find answers

Mac mini Support website

Welcome
Mac mini at a glance
Get started with macOS
Use Mac mini with other devices
Apps

https://support.apple.com/mac/mac-mini
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Find answers
Safety, handling, and regulatory information
Copyright
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Take a tour of Mac mini
Note: This guide is for the current Mac mini with and chips. The illustrations show
Mac mini with . If you’re not sure which Mac mini you have or want to find information and
documentation about other models, see the Apple Support article 

.

Your Mac mini is packed with advanced technologies.

USB-C ports: Mac mini has two USB-C ports, making it easy to connect and charge 
all your favorite accessories, such as a mouse, keyboard, and RAID arrays.

Status indicator light: If the light is on, your Mac mini is awake or in sleep; when 
there’s no light, your Mac mini is turned off.

3.5 mm headphone jack: Plug in stereo headphones or speakers to experience high-
quality sound while listening to music or watching movies. Or plug in an analog 
headset with a built-in mono microphone to make audio and video calls.

Power port: Plug the power cord into the power port on the back of your Mac mini, 
then plug the other end of the cord into a power outlet.

Gigabit Ethernet port: Connect a router or modem to use the internet, or connect to 
another computer to transfer files without using Wi-Fi.

10 Gigabit Ethernet (RJ-45) port: If your Mac mini has the optional 10 Gigabit 
Ethernet port, it can use Nbase-T Ethernet technology, which supports multiple data 
rates for speeds up to 10 Gbit/s over standard twisted-pair copper cable up to 100 
meters (328 feet) in length. Depending on the device you’re connecting to, the cable 
type and technology used, and the cable length, the highest link speed is 
automatically negotiated. For example, if the device you’re connecting to is 10 Gbit/s-
capable and the cable can support that speed, the two devices negotiate the 10 
Gbit/s speed.

See the following table for connection speeds and cable types. Speeds are for cables 
up to 100 meters (328 feet) in length, unless otherwise specified.

Mac mini at a glance

Identify your Mac mini
model

https://support.apple.com/102852
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Cable Type 1 Gbit/s 2.5 Gbit/s 5 Gbit/s 10 Gbit/s

Category 5e Not supported

Category 6  Up to 55 m
(180 feet)

Category 6a

HDMI port: Use an HDMI to DVI Adapter or HDMI cable (sold separately) to connect 
your Mac Mini to a TV or external display. See Connect a display to Mac mini.

Thunderbolt (USB-C) ports: Use any of the three Thunderbolt (USB-C) ports to 
transfer data at Thunderbolt speeds (up to 40 Gbit/s  up to 120 Gbit/s ), connect to a 
display or projector, connect to USB 4 peripherals, and more. The ports can also 
charge devices, such as an iPhone or a rechargeable trackpad or keyboard.

Mac mini with can support up to three displays—two 6K and one 5K. Mac mini with 
can support up to three 6K displays. See Connect a display to Mac mini for more 
information about display configurations.

Power button: Press to turn on your Mac mini. (Choose Apple menu   > Shut Down to 
turn off your Mac mini, or choose Apple menu  > Sleep to put it to sleep.)
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Use accessories

Connect accessories to your Mac mini
You can connect your Mac mini with other devices, like a keyboard, mouse, or trackpad;
wearable devices like AirPods; and more. There are two ways to connect accessories:
wirelessly using Bluetooth technology, or by connecting a cable from the accessory to
one of the USB-C ports on your Mac mini.

Before you begin. Before you connect an accessory to your Mac mini, do the following:

Consult the documentation that came with your accessory.

If you are connecting with a cable, make sure you have the correct cable. You may
also need an adapter to connect the cable to your Mac mini. To learn more about your
ports and their capabilities, see .

Make sure your Mac mini is updated to the latest version of macOS.

Connect a wireless accessory

Turn Bluetooth on. Click  in the menu bar. If the Bluetooth icon  is gray with a line
through it, it’s turned off. Click it to turn on Bluetooth.

Pair a Bluetooth accessory. The first time you use a Bluetooth accessory with your
Mac mini, you must pair them. Consult the documentation that came with your accessory
to make sure it is ready to pair—for instance, you may need to flip a switch on the
accessory to turn on Bluetooth. Both your Mac and the accessory must be turned on and
near each other.

When your accessory is ready to pair, open System Settings on your Mac and click
Bluetooth in the sidebar. Select the accessory in the Nearby Devices list, then click
Connect.

Connect a Bluetooth accessory. Your accessory automatically connects to your
Mac mini after you’ve paired it. To see what Bluetooth devices you have connected to
your Mac mini, click   in the menu bar, then move your pointer over Bluetooth and click
. Accessories that appear in the list with a blue (or a different color) icon are connected.

If your accessory isn’t automatically connecting, open System Settings on your Mac and
click Bluetooth. Make sure the accessory appears in the My Devices list. If it doesn’t
appear, follow the steps to pair the accessory.

Take a tour of Mac mini
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Disconnect or forget a Bluetooth accessory. To disconnect a Bluetooth accessory,
open System Settings on your Mac and click Bluetooth. In the My Devices list, move your
pointer over the accessory, then click Disconnect when it appears. To forget a Bluetooth
accessory so your Mac mini doesn’t automatically connect to it, click  next to the
accessory, then click Forget This Device.

Connect a Magic Keyboard, Magic Mouse, or Magic Trackpad. Connect the Magic
Keyboard, Magic Mouse, or Magic Trackpad to your Mac mini using the cable provided
with the accessory. Then, slide the switch on your accessory to on, so that green is
visible. Your accessory then pairs with your Mac.

After the accessory is paired with your Mac mini, you can disconnect the cable and use
the accessory wirelessly. Your Magic Mouse, Magic Trackpad, or Magic Keyboard
automatically connects to your Mac when Bluetooth is turned on.

For information about input devices, see  and .

Note: Magic Keyboard, Magic Trackpad, and Magic Mouse behave like a wired keyboard
or pointing device when connected using their included cable. Bluetooth isn’t used, and
all communication is over the cable.

Connect AirPods with your Mac mini. To pair and connect AirPods, see 
.

Connect an accessory with a cable

Some accessories can be connected to your Mac mini with a cable. Depending on the
capabilities of the accessory and the cable, you may also be able to charge the accessory
or transfer data when connected.

Consult the documentation that came with your accessory before connecting it. Some
accessories have an additional power source that also needs to be plugged in.

To connect an accessory, you need to use a cable that fits both the port on your
accessory as well as the USB-C port on your Mac mini. If the cable doesn’t have the right
connector for your Mac, you may use an adapter to connect the cable. For more
information about adapters, what they look like, and what ports to use, see 

.

Tip: Some accessories need to be approved the first time they’re connected. See
 to learn more.

You also need to connect a display when you first set up Mac mini (see 
 for details).

Magic Mouse Magic Trackpad

Pair AirPods
with an Apple Device

Adapters for
the Thunderbolt or USB-C ports on your Mac

Allow accessories to connect to Mac

Connect a display
to Mac mini

https://support.apple.com/guide/airpods/dev7c85810f2
https://support.apple.com/102477
help:anchor='mchlf779ae93'%20bookID='com.apple.machelp'
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Learn more. See  and . To learn more about
connecting a Magic Mouse, Magic Trackpad, or Magic Keyboard, see 

. If you see a note that USB
devices are disabled, see .

Magic Keyboard with Touch ID
The wireless Magic Keyboard with Touch ID and the Magic Keyboard with Touch ID and
Numeric Keypad (shown below) have built-in features that make it easy to enter emoji,
switch keyboard languages, lock your Mac mini, and perform many system functions with
the touch of a key. You can also use a fingerprint to sign in and make purchases using
Apple Pay.

To connect your Magic Keyboard with Touch ID to your Mac mini, see 
.

Turn the keyboard on or off. Slide the on/off switch on the back edge of the keyboard to
turn it on   (so green is visible) or off. If your keyboard isn’t recognized by your Mac,
connect it to your Mac with a USB-C Charge Cable or USB-C to Lightning cable to pair it,
then disconnect the cable to use it wirelessly. Use the same cable to charge your
keyboard.

Lock your Mac mini. Quickly press Touch ID. To unlock your Mac mini, lightly touch
Touch ID, or press any key and type your password.

Set up Touch ID. You can use your fingerprint to unlock your Mac and make purchases
from the App Store, Apple TV app, and Apple Books, and on websites using Apple Pay. If
you don’t set up Touch ID when you set up your Mac, you can do it later in the Touch ID &
Password settings in System Settings. For more information about Touch ID, see 

. For information about Apple Pay, see .

Use Touch ID. Place your finger lightly on Touch ID. When you first start up or restart
your Mac, you need to type your password to log in to your Mac mini. After that,
whenever you’re asked for your password to unlock the screen or make purchases, you
can use Touch ID. If you set up fast user switching with your Mac mini, you can also use
your fingerprint to switch from another user’s account to your own. For more information,
see .

Set keyboard settings. To specify options for your keyboard and the Function
(Fn)/Globe key , open System Settings, click Keyboard in the sidebar, and choose
options to change your keyboard or input source, show emoji and symbols, start
dictation, or define functions.

Bluetooth settings on Mac About USB on Mac
Set up your Magic

Keyboard, Magic Mouse, or Magic Trackpad with your Mac
If you see USB Devices Disabled on your Mac

Connect
accessories to your Mac mini

Set up
your Mac mini Use Wallet and Apple Pay

Use Touch ID on Mac

help:anchor='blth8111'%20bookID='com.apple.machelp'
https://support.apple.com/guide/mac-help/mchlp1161/
https://support.apple.com/119917
https://support.apple.com/102204
help:anchor='mchl4773988b'%20bookID='com.apple.machelp'
help:anchor='mchl16fbf90a'%20bookID='com.apple.machelp'
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Use emoji or switch keyboard languages. Press  to switch to a different keyboard.
Press  repeatedly to cycle through emoji options or other languages you specify in
Keyboard settings, or press twice quickly to start dictation (if you set that preference).
On Magic Keyboard with Touch ID, the key is in the bottom-left corner.

Use function keys. The function keys on the top row provide shortcuts for these
common system functions:

Brightness (F1, F2): Press   or  to decrease or increase the brightness of the
screen.

Mission Control (F3): Press   to view what’s running on your Mac, including all your
spaces and open windows.

Spotlight Search (F4): Press   to open Spotlight and search for something on your
Mac.

Dictation/Siri (F5): Press   to activate dictation—you can dictate text wherever you
can type (for example, in Messages, Mail, Pages, and other apps). Press and hold  to
activate Siri, then immediately speak your request.

Do Not Disturb (F6): Press  to turn Do Not Disturb on or off. When Do Not Disturb is
on, you won’t see or hear notifications on your Mac, but you can view them in
Notification Center.

Media (F7, F8, F9): Press   to rewind,  to play or pause, or   to fast-forward a
song, movie, or slideshow.

Mute (F10): Press   to mute the sound.

Volume (F11, F12): Press   or  to decrease or increase the sound volume.

Use alternate functions. Function keys may perform actions for specific apps or may
have alternative functions—for example, the F11 key can also hide all open windows and
show the desktop. To trigger the alternative function associated with the key, press and
hold the Function (Fn)/Globe key  while you press a function key.

Use keyboard shortcuts. You can press two or more keys at the same time to quickly do
things on your Mac that you’d normally do with a trackpad, mouse, or other device. For
example, press Command-C to copy selected text, then click where you want to paste
the text and press Command-V. For a list of commonly used keyboard shortcuts, see

. If you’re new to the Mac, you might also be interested
in .
Keyboard shortcuts on your Mac

Are you new to Mac?
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Magic Mouse
You can use Magic Mouse anywhere within range of your computer. When you need to
charge the mouse or if you need to pair it again, connect it to your Mac mini using a USB-
C Charge Cable or USB-C to Lightning cable.

To connect your Magic Mouse to your Mac mini, see 
.

Here are some common gestures you can use with your Magic Mouse.

Gesture Action

Turn on/off: Slide the on/off switch  on the bottom of the
mouse to turn it on (so green is visible).

Click: Press the upper surface of the mouse to click or double-
click.

Secondary click (that is, right-click): Press the left or right
side of the mouse to perform a “secondary click.” (To enable
right- and left-click, in System Settings, click Mouse, then select
“Secondary click.”) Or press the Control key on the keyboard as
you click the mouse.

360º scroll: Brush one finger along the surface to scroll or pan
in any direction.

Screen zoom: Hold down the Control key and scroll with one
finger to enlarge items on the screen. (To enable screen zoom, in
System Settings, click Accessibility, click Zoom, then select “Use
scroll gesture with modifier keys to zoom.”)

Two-finger swipe: Swipe left or right to move through pages,
photos, and more.

Connect accessories to your
Mac mini
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Customize your mouse. To adjust settings such as tracking and scrolling speed, and to
enable or customize gestures, click Mouse in System Settings.

Magic Trackpad
You can do a lot on your Mac mini using simple trackpad gestures—scroll through
webpages, zoom in on documents, rotate photos, and more. With the Force Touch
trackpad, pressure-sensing capabilities add another level of interactivity. The trackpad
provides feedback—when you drag or rotate objects, you feel a subtle vibration when
they’re aligned, allowing you to work with greater precision. For examples of force click
options, see the Apple Support article .

To connect your Magic Trackpad to your Mac mini, see 
.

Here are some common gestures you can use with your Magic Trackpad.

How to use the Force Touch trackpad

Connect accessories to your
Mac mini

https://support.apple.com/102309
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Gesture Action

Click: Press anywhere on the trackpad. Or enable “Tap to click”
in Trackpad settings, and simply tap.

Force click: Click and then press deeper. You can use force click
to look up more information—click a word to see its definition, or
an address to see a preview that you can open in Maps.

Secondary click (that is, right-click): Click with two fingers to
open shortcut menus. If “Tap to click” is enabled, tap or click
with two fingers. Or press the Control key on the keyboard as
you click the trackpad.

Two-finger scroll: Slide two fingers up or down to scroll.

Pinch to zoom: Pinch your thumb and finger open or closed to
zoom in or out of photos and webpages.

Swipe to navigate: Swipe left or right with two fingers to flip
through webpages, documents, and more—like turning a page in
a book.

Open Launchpad: Quickly open apps in Launchpad. Pinch
closed with four or five fingers, then click an app to open it.

Swipe between apps: To switch from one full-screen app to
another, swipe left or right with three or four fingers.

Customize your gestures. In System Settings, click Trackpad. In Trackpad settings you
can:

Learn more about each gesture

Set the click pressure you prefer to use

Decide whether to use pressure-sensing features

Customize other trackpad features

Tip: If you’re force clicking when you don’t intend to, try adjusting the click pressure
to a firmer setting in Trackpad settings. Or click the pop-up menu next to “Look up &
data detectors” and choose “Tap with Three Fingers.”
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Charge the batteries in wireless accessories
The Magic Keyboard, Magic Mouse, and Magic Trackpad each have a built-in
rechargeable battery.

Check the battery level. Click  in the menu bar, move the pointer over the Bluetooth
item, then click the arrow next to it.

Charge the battery. Connect your Magic Keyboard, Magic Mouse, or Magic Trackpad to
your Mac with a USB-C Charge Cable or USB-C to Lightning cable.

Tip: To charge the battery faster, be sure your input device is turned on when you
connect it to your Mac mini.

Learn more. See  or visit .

Use adapters with your Mac mini
The following Apple adapters are available to connect external devices, displays, and
more to the USB-C ports on your Mac mini.

Adapter Description

Thunderbolt 3 (USB-C) to Thunderbolt 2 Adapter: Connect
your Mac mini to Thunderbolt 2 devices or a Thunderbolt display.

USB-C Digital AV Multiport Adapter: Connect your Mac mini to
an HDMI device, while also connecting a standard USB device.

USB-C VGA Multiport Adapter: Connect your Mac mini to a
VGA projector or display, while also connecting a standard USB
device.

USB-C to USB Adapter: Connect your Mac mini to your flash
drive, camera, or other standard USB devices.

USB-C to SD Card Reader Adapter: Connect your Mac mini to a
SD Card to transfer high-resolution photos and videos.

Disposal and recycling information Apple Lithium-ion Batteries

https://www.apple.com/batteries/
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Learn more. See the Apple Support article 
.

Connect up to three displays, two with up to 6K resolution at 60 Hz over Thunderbolt,
and one with up to 5K resolution at 60 Hz over Thunderbolt or 4K resolution at 60 Hz
over HDMI.

Connect up to two displays, one with up to 5K resolution at 60 Hz over Thunderbolt,
and one with up to 8K resolution at 60 Hz or 4K resolution at 240 Hz over
Thunderbolt or HDMI.

For Mac mini, you can connect up to three external displays in the following 
configurations:

Connect up to three displays, each with up to 6K resolution at 60 Hz over
Thunderbolt or HDMI.

Connect up to two displays, one with up to 6K resolution at 60 Hz over Thunderbolt,
and one with up to 8K resolution at 60 Hz or 4K resolution at 240 Hz over
Thunderbolt or HDMI.

If you’re not sure how many external displays your Mac mini supports, check your
Technical Specifications. Open System Settings, choose Help > Mac mini Specifications,
then locate Video Support (you may need to scroll).

Note: When connecting multiple displays, connect the display with the highest resolution
first.

To learn more about using an 8K display with your Mac mini, see the Apple Support
article .

Adapters for the Thunderbolt or USB-C ports
on your Mac

Adapters and other accessories are sold separately. Visit apple.com, your local
Apple Store, or other resellers for more information and availability. Review the 
documentation or check with the manufacturer to make sure you’re choosing the right 
adapter for your Mac mini.

Connect a display to Mac mini
The HDMI and USB-C ports on your Mac mini support video output, so you can connect 
an external display, a projector, or a high resolution TV.

For Mac mini, you can connect up to three displays in the following configurations:

Use an 8K display with your Mac

https://support.apple.com/102477
https://apple.com/store
https://support.apple.com/102236
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Tip: If you have a high resolution TV connected to an Apple TV, you can use AirPlay to
mirror your screen. See  for details.

If your display has a connector that doesn’t match the port you want to use, you may be
able to use it with an adapter (sold separately). Visit , your local Apple Store, or
other resellers for more information and availability. Review the display’s documentation
or check with the display’s manufacturer to make sure you choose the right product. See
the Apple Support article .

To connect this device to Mac mini Use a cable, or an adapter and cable

Apple Studio Display The Thunderbolt cable that came with your
display or any supported Thunderbolt 3 (USB-
C) cable.

Apple Pro Display XDR (Mac mini with Apple
silicon only)

The Thunderbolt cable that came with your
display or any supported Thunderbolt 3 (USB-
C) cable.

Thunderbolt 3 (USB-C) display Thunderbolt 3 (USB-C) cable.

USB-C display USB-C (USB 3.1) cable.

HDMI display or HDTV The HDMI cable that came with your display or
HDTV or any supported HDMI cable.

Thunderbolt 2 display Thunderbolt 3 (USB-C) to Thunderbolt 2
adapter and the cable that came with your
Thunderbolt 2 display.

VGA display or projector USB-C VGA Multiport adapter and the cable
that came with your display or projector.

DisplayPort or Mini DisplayPort display USB-C to DisplayPort or Mini DisplayPort
adapter and the cable that came with your
display.

DVI display or projector USB-C to DVI adapter and the cable that came
with your display or projector.

Adjust and arrange displays. After you connect a display or projector, use Displays
settings in System Settings to turn screen mirroring on or off, arrange and manage
multiple displays, and make other adjustments to color, resolution, and more. See

.

Troubleshooting. To troubleshoot an issue with an external display, see 
.

Stream content on a larger screen with AirPlay

apple.com

Adapters for the Thunderbolt or USB-C ports on your Mac

Connect one or more external displays with your Mac

If your external
display is dark or low resolution

https://apple.com/
https://support.apple.com/102477
help:anchor='mchl7c7ebe08'%20bookID='com.apple.machelp'
https://support.apple.com/102501
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Subscription required for Apple TV+.
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Set up your Mac

Set up your Mac mini
When you set up your new Mac mini, you can customize certain settings for your Mac, set
up features like Touch ID, and transfer data from another computer. If you already have a
Mac, iPad, or iPhone, you may also have the option to skip several steps by using your
existing settings in order to set up your new Mac more quickly.

If you need additional support while setting up your Mac, you can speak with an Apple
expert by chat, email, on the phone, or set up an appointment at the Genius Bar. Learn
more at .

Setup Assistant walks you through the settings needed to start using your Mac. When
setup is complete, see  for next steps.

If you’d like to walk through each step of the process, choose a link below.

If you’re new to Mac: See .

If you’re already a Mac user: See .

Set up your Mac mini for new Mac users
This walk-through covers each step of the setup process and is intended to be used
alongside Setup Assistant.

Tip: Some steps may require you to scroll to select an option. If you have a Magic
Mouse or Magic Trackpad and you’re not sure how to scroll on a Mac, just slide two
fingers up and down on your trackpad. If you’d like to adjust gestures later, learn how to
do so with  or .

Get started with macOS

Genius Bar Reservation and Apple Support Options

When you’re done setting up your Mac mini

Set up your Mac mini for new Mac users

Set up your Mac mini for current Mac users

Magic Mouse Magic Trackpad

https://www.apple.com/retail/geniusbar/
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Before you begin

If you have an iPhone or iPad, keep these close at hand during setup, since some
steps may require verification on another device.

Connect a display to your Mac mini. Consult the documentation that came with your
display to understand what port and cable you need to use. For more information, see

.

You have the opportunity to transfer data from another computer, like a Windows PC,
during setup. If you want to do this, make sure that you have the computer that you
want to transfer data from, and that it is updated to the latest available software
version.

Setup Assistant makes setting up your Mac mini easy and shouldn’t take too long to
complete. If you choose to transfer data, however, set aside additional time.

Connect a mouse or trackpad and keyboard

At the beginning of setup, you can connect a mouse or trackpad and keyboard to your
Mac mini.

To use a mouse, keyboard, or trackpad with your Mac, you need to pair them. You may
also use a cable to physically connect the accessory to your Mac. Consult the
documentation that came with your accessory to learn how to pair or connect it, or see

.

If you have additional questions about connecting a mouse, trackpad, or keyboard during
setup, see the Apple Support Article 

.

Set your language, country or region, and connect to Wi-Fi

Choose your language. This sets the language for your Mac. To change the language
later, open System Settings, click General in the sidebar, click Language & Region, then
choose your options.

Set your country or region. This sets the format of dates, currencies, temperature, and
more for your Mac. To change your country or region later, open System Settings, click
General in the sidebar, click Language & Region, then choose your options.

Connect a display to Mac mini

Connect accessories to your Mac

If your keyboard or mouse won’t connect during
Mac setup

https://support.apple.com/108797
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Turn on Accessibility features. View accessibility options for Vision, Motor, Hearing,
and Cognitive abilities, or click Not Now. To learn more, see .

Connect to a Wi-Fi network. Choose your Wi-Fi network and enter the password, if
necessary. If you’re using Ethernet, you can also click Other Network Options and follow
the onscreen instructions.

To change the Wi-Fi network later, open System Settings, click Wi-Fi in the sidebar, then
choose a network and enter the password, if necessary.

Transfer information from another computer

You can migrate your data—like files, contacts, accounts, and more—from a Windows PC
to your new Mac. If you have another Mac you’d like to transfer from, see 

. You can either transfer the data wirelessly, or you can
connect your Windows PC to your Mac mini with an Ethernet cable.

Accessibility on your Mac

Transfer
information from another Mac
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Before you begin. Ensure that your Windows PC is updated to the latest available
software version. Then download Migration Assistant on your Windows PC. To download
the right Migration Assistant for your operating system, and to learn more about this
process, see .

Transfer data wirelessly. Your Windows PC and your new Mac must be on the same Wi-
Fi network. Click your Windows PC on the setup screen and follow the instructions.

Transfer data using an Ethernet cable. Directly connect your Windows PC to your
Mac mini with an Ethernet cable. You may need an adapter to connect the Ethernet cable
to your Windows PC, depending on its ports. After you connect them, click your Windows
PC on the setup screen and follow the instructions.

Transfer data later. You may also choose to not transfer data at this time. If so, click Not
Now in the Migration Assistant Window. To transfer data after setup, see 

.

Transfer from PC to Mac with Migration Assistant

Transfer your
data to your new Mac mini

https://support.apple.com/102565
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Sign in to your Apple Account and set up your computer account

Sign in to your Apple Account. If you already have another Apple device, like an iPhone
or iPad, you likely have an Apple Account. If you don’t have an Apple Account, you can
create one now (it’s free).

Your Apple Account consists of an email address and a password. It’s the account you
use for everything you do with Apple—including using the App Store, Apple TV app,
iCloud, and more. Your Apple Account is not the same as the username and password
you use to sign in to your Mac computer account. To learn more, see 

.

Tip: It’s best to have your own Apple Account and not share it.

On this screen, do any of the following:

If you have an Apple Account: Enter your email address and password for your Apple
Account. If you have an iPhone or iPad, a verification code is sent to this device. If you
don’t have an iPhone or iPad, a verification code is texted to the phone number
associated with your Apple Account. If you don’t receive the verification code or you
don’t receive the text, follow the onscreen prompts.

If you don’t have an Apple Account: Click “Create new Apple Account.”

If you have forgotten your Apple Account or password: Click “Forgot Apple Account
or password.”

If you don’t want to sign in to or create an Apple Account at this time: Click Set Up
Later. After setup, you can sign in to an Apple Account or create a new Apple
Account. Open System Settings, then click “Sign in to your Apple Account” in the
sidebar.

Note: After you’ve signed in to your Apple Account, read the terms and conditions. To
accept, check the box, then click Agree and proceed.

Create a computer account. Add your name, then create an account name and
password, which can later be used to unlock your Mac mini or approve other actions. You
can add an optional hint to help retrieve your computer account’s password if you forget
it. To change your account’s login picture, click it, then choose an option.

Apple Account on
Mac
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Note: Your computer account is not the same as your Apple Account. However, if you
ever forget the password to unlock your Mac and if you checked the option to allow your
Apple Account to reset your user account password during setup, you can use your Apple
Account to reset the password.

Make this your new Mac

If you’ve already set up another device with iOS 15 or later or iPadOS 15 or later, a screen
appears for express setup, Make This Your New Mac. If you don’t have an iPhone or iPad
with the right software version, you do not see this step. (Not sure what software version
is on your iPhone or iPad? See .)

When you use Make This Your New Mac, you skip several of the setup steps by using the
settings stored in your iCloud account. To use your current settings, click Continue. If you
have paired a Magic Keyboard with Touch ID, the setup process jumps to 

. If you use your current settings and haven’t paired a Magic Keyboard with
Touch ID, the setup process is complete; see .

If you want to customize your settings for your new Mac mini, click Customize Settings
and proceed to the next step.

Find the software version on your iPhone, iPad, or iPod

Set up Touch ID
and Apple Pay

When you’re done setting up your Mac mini

https://support.apple.com/109065
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Customize your Mac’s privacy and security settings, turn on Screen Time, and
enable Siri

Enable Location Services. Choose whether to allow apps like Maps to use your Mac’s
location. To change your Location Services settings later, open System Settings, click
Privacy & Security in the sidebar, then click Location Services and choose your options.

If you don’t enable Location Services, you see a screen to choose your time zone.

Share analytics with Apple and Developers. Choose whether to send diagnostics and
data to Apple, and whether Apple can share crash and usage data with developers. To
change these settings later, open System Settings, click Privacy & Security in the sidebar,
click Analytics & Improvements (you may need to scroll), and choose options.

Set up Screen Time. Screen Time lets you see your daily and weekly usage of your
Mac mini, set limits on how long you can use certain apps, manage children’s screen
time, and more. To turn on, click Continue; otherwise click Set Up Later. If you choose to
set up later, open System Settings and click Screen Time in the sidebar to choose your
options. For more options and details, see .

Secure your data with FileVault. FileVault helps to keep your data secure. During setup,
you can choose to turn on FileVault to protect your data, and you can choose to allow
your iCloud account to unlock your disk if you forget your password. To learn more about
FileVault and how to set it up later, see .

Enable Siri and “Hey Siri.” You can turn on Siri and “Hey Siri” (so you can speak your Siri
requests) during setup. To set up Siri, click Enable Ask Siri. To set up “Hey Siri,” speak
several Siri commands when prompted. To turn on Siri and “Hey Siri” later, open System
Settings, click Apple Intelligence & Siri in the sidebar, and choose your options. To learn
more about Siri, see .

You may also choose to share audio with Apple to improve Siri during setup. You can
always change whether or not to share audio later. Open System Settings, click Privacy &
Security in the sidebar, click Analytics & Improvements (you may need to scroll), and
choose your options.

Set up Touch ID and Apple Pay

Note: These steps appear if you have paired a Magic Keyboard with Touch ID.

Set up Touch ID. You can add a fingerprint to Touch ID (the top-right button on your
keyboard) during setup, which you can use to unlock your Mac mini, authorize purchases
with Apple Pay, and sign in to some third-party apps. Follow the onscreen instructions to
set up Touch ID. To set up Touch ID later, or to add additional fingerprints, open System
Settings, then click Touch ID & Password in the sidebar. To add a fingerprint, click   and
follow the onscreen instructions.

Screen Time on Mac

Encrypt Mac data with FileVault

Siri on your Mac

help:anchor='mh11785'%20bookID='com.apple.machelp'
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To learn more, see .

Set up Apple Pay. If you set up Touch ID, you can set up Apple Pay and add a debit,
credit, or store card that can be used to make purchases with Touch ID. Enter your card
details and follow the on-screen prompts. If you already use a card for media purchases,
you might be prompted to verify this card first.

To set up Apple Pay or add additional cards later, open System Settings, then click Wallet
& Apple Pay. Follow the onscreen prompts to set up Apple Pay.

Note: The card issuer determines whether your card is eligible to use with Apple Pay, and
may ask you to provide additional information to complete the verification process. Many
credit and debit cards can be used with Apple Pay. For information about Apple Pay
availability and current credit card issuers, see the Apple Support article 

.

Set desktop appearance

Choose your look. Select Light, Dark, or Auto for your desktop appearance. Later, if you
want to change the choice you make during setup, open System Settings, click
Appearance, then select an option. You can also set other appearance settings, such as
highlight color or sidebar icon size.

Note: If you choose to do express setup with Make This Your New Mac, you skip this
step.

Setup is complete

Your new Mac mini is ready to go. See  for
next steps.

Set up your Mac mini for current Mac users
This walk-through covers each step of the setup process and is intended to be used
alongside Setup Assistant.

Use Touch ID on Mac

Apple Pay
participating banks

When you’re done setting up your Mac mini

help:anchor='mchl16fbf90a'%20bookID='com.apple.machelp'
https://support.apple.com/HT204916
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Before you begin

Keep your other Mac, or your iPhone or iPad, close at hand during setup, since some
steps may require verification on another device.

Connect a display to your Mac mini. Consult the documentation that came with your
display to understand what port and cable you need to use. For more information, see

.

You have the opportunity to transfer data from another Mac during setup. If you want
to do this, make sure that you have the computer that you want to transfer data from,
and that it is updated to the latest available software version.

Setup Assistant makes setting up your Mac mini easy and shouldn’t take too long to
complete. If you choose to transfer data, however, set aside additional time.

Connect a mouse or trackpad and keyboard

At the beginning of setup, you can connect a mouse or trackpad and keyboard to your
Mac mini.

To use a mouse, trackpad, or keyboard with your Mac, you need to pair them. You may
also use a cable to physically connect the accessory to your Mac. Consult the
documentation that came with your accessory to learn how to pair or connect it, or see

.

If you have additional questions about connecting a mouse, trackpad, or keyboard during
setup, see the Apple Support Article 

.

Set your language, country or region, and connect to Wi-Fi

Choose your language. This sets the language for your Mac. To change the language
later, open System Settings, click General in the sidebar, click Language & Region, then
choose your options.

Set your country or region. This sets the format of dates, currencies, temperature, and
more for your Mac. To change the country or region later, open System Settings, click
General in the sidebar, click Language & Region, then choose your options.

Connect a display to Mac mini

Connect accessories to your Mac

If your keyboard or mouse won’t connect during
Mac setup

https://support.apple.com/108797
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Turn on Accessibility features. View accessibility options for Vision, Motor, Hearing,
and Cognitive abilities, or click Not Now. To learn more, see .

Connect to a Wi-Fi network. Choose your Wi-Fi network and enter the password, if
necessary. If you’re using Ethernet, you can also click Other Network Options and follow
the onscreen instructions.

To change the Wi-Fi network later, open System Settings, click Wi-Fi in the sidebar, then
choose a network and enter the password, if necessary.

Tip: After setup, if you don’t see the Wi-Fi status icon   in the menu bar, you can
add it. Open System Settings, click Control Center in the sidebar, then select “Show in
Menu Bar” for Wi-Fi.

Transfer information from another Mac

You can migrate your data—like files, contacts, accounts, and more—from another Mac to
your new Mac mini. You may also choose to transfer information from a Time Machine
backup or a startup disk located on your Mac. When transferring from another Mac, you
can either transfer the data wirelessly, or you can connect your Mac to your Mac mini with
an Ethernet cable.

If you’re restoring your Mac, see .

Accessibility on your Mac

Restore your Mac from a back up

https://support.apple.com/102551
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Before you begin. Ensure that the other Mac is updated to the latest available software
version. Then open Migration Assistant on the Mac that you are transferring from.
Migration Assistant is located in the Utilities folder of the Applications folder.

Transfer data wirelessly. Transfer information wirelessly from another Mac to your new
Mac, if both computers are near each other. Click your other Mac on the setup screen,
and follow the instructions.

Transfer data using an Ethernet cable. Directly connect your Mac mini to the other Mac
with an Ethernet cable. You may need an adapter to connect the Ethernet cable to your
other Mac, depending on its ports. After you connect them, click your other Mac on the
setup screen and follow the instructions.

Transfer data later. You may also choose to not transfer data at this time. If so, click Not
Now in the Migration Assistant Window. To transfer data after setup, see 

.

Learn more. To learn more about this process, see 
.

Transfer your
data to your new Mac mini

Transfer to a new Mac with Migration
Assistant

https://support.apple.com/102613
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Sign in to your Apple Account and set up your computer account

Sign in to your Apple Account. When you sign in to your Apple Account during setup,
you receive a verification code on your other Apple devices. To proceed, enter the
verification code on your new Mac mini. If you don’t receive the code, or don’t have the
device, you may choose to have the verification code sent to you by text or phone call. If
you can’t use the phone number associated with your Apple Account, choose “Can’t use
this number” and follow the onscreen instructions.

If you need to create an Apple Account, choose “Create new Apple Account.” If you have
forgotten your Apple Account or password, choose “Forgot Apple Account or password.”

If you don’t want to sign in to or create a new Apple Account now, click Set Up Later.
After setup, you can sign in to an Apple Account or create a new Apple Account. Open
System Settings, then click “Sign in to your Apple Account” in the sidebar.

Note: After you’ve signed in to your Apple Account, read the terms and conditions. To
accept, check the box, then click Agree and proceed.

Create a computer account. Add your name and create an account name and password,
which can later be used to unlock your Mac mini or approve other actions. You can add
an optional hint to help retrieve your computer account’s password if you forget it. To
change your account’s login picture, click it, then choose an option.

Note: Your computer account is not the same as your Apple Account. However, if you
ever forget the password to unlock your Mac and if you checked the option to allow your
Apple Account to reset your user account password during setup, you can use your Apple
Account to reset the password.
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Make this your new Mac

If you’ve already set up another device with macOS 12 or later, iOS 15 or later, or iPadOS
15 or later, a screen appears for express setup, Make This Your New Mac. If you don’t
have a Mac, iPad, or iPhone with the right software version, you don’t see this step. (Not
sure what software version is on your Mac, iPhone, or iPad? See 

 or .)

When you use Make This Your New Mac, you skip several of the setup steps by using the
settings stored in your iCloud account. To use your current settings, click Continue. If you
have paired a Magic Keyboard with Touch ID, the setup process jumps to 

. If you use your current settings and haven’t paired a Magic Keyboard with
Touch ID, the setup process is complete; see .

If you want to customize your settings for your new Mac mini, click Customize Settings
and proceed to the next step.

Customize your Mac’s privacy and security settings, turn on Screen Time, and
enable Siri

Enable Location Services. Choose whether to allow apps like Maps to use your Mac’s
location. To change your Location Services settings later, open System Settings, click
Privacy & Security in the sidebar, then click Location Services and choose your options.

If you don’t choose to enable location services, you see a screen to choose your time
zone.

Share analytics with Apple and Developers. Choose whether to send diagnostics and
data to Apple, and whether Apple can share crash and usage data with developers. To
change these settings later, open System Settings, click Privacy & Security in the sidebar,
click Analytics & Improvements (you may need to scroll), then choose options.

Set up Screen Time. Screen Time lets you see your daily and weekly usage of your Mac,
set limits on how long you can use certain apps, manage children’s screen time, and
more. To turn on Screen Time, click Continue; otherwise click Set Up Later. If you choose
to set up later, open System Settings, then click Screen Time in the sidebar to choose
your options. For more options and details, see .

Secure your data with FileVault. FileVault helps to keep your data secure. During setup,
you can choose to turn on FileVault to protect your data, and you can choose to allow
your iCloud account to unlock your disk if you forget your password. To learn more about
FileVault, and how to set it up later if you choose to not set up now, see 

.

Find out which macOS
your Mac is using Find the software version on your iPhone, iPad, or iPod touch

Set up Touch ID
and Apple Pay

When you’re done setting up your Mac mini

Screen Time on Mac

Encrypt Mac data
with FileVault

https://support.apple.com/109033
https://support.apple.com/109065
help:anchor='mh11785'%20bookID='com.apple.machelp'
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Enable Siri and “Hey Siri.” You can turn on Siri and “Hey Siri” (so you can speak your Siri
requests) during setup. To set up Siri, click Enable Ask Siri. To set up “Hey Siri,” speak
several Siri commands when prompted. To turn on Siri and “Hey Siri” later, open System
Settings, click Apple Intelligence & Siri in the sidebar, then choose your options. To learn
more about Siri, see .

You may also choose to share audio with Apple to improve Siri during setup. You can
always change whether or not to share audio later. Open System Settings, click Privacy &
Security in the sidebar, click Analytics & Improvements (you may need to scroll), then
choose your options.

Set up Touch ID and Apple Pay

Note: These steps appear if you have paired a Magic Keyboard with Touch ID.

Set up Touch ID. You can add a fingerprint to Touch ID, which you can use to unlock your
Mac mini, authorize purchases with Apple Pay, and sign in to some third-party apps.
Follow the onscreen instructions to set up Touch ID. To set up Touch ID later, or to add
additional fingerprints, open System Settings, then click Touch ID & Password in the
sidebar. To add a fingerprint, click   and follow the onscreen instructions.

To learn more, see .

Set up Apple Pay. If you set up Touch ID, you can set up Apple Pay and add a debit,
credit, or store card that can be used to make purchases with Touch ID. Enter your card
details and follow the onscreen prompts. If you already use a card for media purchases,
you might be prompted to verify this card first.

To set up Apple Pay or add additional cards later, open System Settings, then click Wallet
& Apple Pay. Follow the onscreen prompts to set up Apple Pay.

Note: The card issuer determines whether your card is eligible to use with Apple Pay, and
may ask you to provide additional information to complete the verification process. Many
credit and debit cards can be used with Apple Pay. For information about Apple Pay
availability and current credit card issuers, see the Apple Support article 

.

Set desktop appearance

Choose your look. Select Light, Dark, or Auto for your desktop appearance. Later, if you
want to change the choice you make during setup, open System Settings, click
Appearance, then select an option. You can also set other appearance settings, such as
highlight color or sidebar icon size.

Note: If you choose to do express setup with Make This Your New Mac, you skip this
step.

Siri on your Mac

Use Touch ID on Mac

Apple Pay
participating banks

help:anchor='mchl16fbf90a'%20bookID='com.apple.machelp'
https://support.apple.com/HT204916
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Setup is complete

Your new Mac mini is ready to go. See  for
next steps.

When you’re done setting up your Mac mini
After you’re done setting up your Mac mini, you can now start making it yours. Start to
personalize your Mac by  and , adjusting text display by

, or 
. Learn how to seamlessly use your Mac mini with other Apple devices with 

 and . If you’re interested in apps,
learn more about how to  or how to install new apps, including iPhone and
iPad apps that you have previously purchased, on your Mac with . (Note that
many, but not all, iPhone and iPad apps are available on Mac.)

If you’re new to Mac, see  to learn some helpful tips. You may also
find  and the Apple Support article 

 helpful. Whether you’re new to Mac or looking for a refresher on macOS, learn
more about getting started with your Mac and explore the , ,

, , and more.

Finally, get to know your new Mac mini. Learn more about the USB-C ports, the Ethernet
port, and more with . You can also  or 

, and learn and adjust gestures with  or .

When you’re done setting up your Mac mini

setting up email calendar accounts
making text and other items on the screen bigger customizing the desktop picture on
your Mac Work
with multiple devices Share content between devices

work with apps
App Store

Are you new to Mac?
What’s it called on my Mac? Mac tips for Windows

switchers
Desktop and menu bar Finder

Dock Control Center

Take a tour of Mac mini connect a display connect
accessories Magic Trackpad Magic Mouse

help:anchor='mail35803'%20bookID='com.apple.Mail.help'
help:anchor='icl4308d6701'%20bookID='com.apple.iCal.help'
help:anchor='mchld786f2cd'%20bookID='com.apple.machelp'
help:anchor='mchlp3013'%20bookID='com.apple.machelp'
help:anchor='cpmh0038'%20bookID='com.apple.machelp'
https://support.apple.com/102323
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Apple Account and iCloud

Apple Account on Mac
Your Apple Account lets you access all Apple services. Use your Apple Account to
download apps from the App Store; access media in Apple Music, Apple Podcasts, Apple
TV, and Apple Books; keep your content up to date across devices using iCloud; set up a
Family Sharing group; and more.

You can also use your Apple Account to access other apps and websites (see 
).

Important: If you forget your Apple Account password, you don’t need to create a new
Apple Account. Just click Forgot Password in the sign-in window to retrieve your
password.

If other family members use Apple devices, make sure that each family member has their
own Apple Account. You can create Apple Accounts for your kids and share purchases
and subscriptions with Family Sharing, described later in this section.

To view the services you can use with your Apple Account, see the Apple Support article

All in one place. Manage everything related to your Apple Account in the same place.
Open System Settings on your Mac mini—your Apple Account and Family Sharing settings
are at the top of the sidebar. To sign in to your Apple Account, if you haven’t already, click
“Sign in to your Apple Account” at the top of the sidebar.

Update account, security, and payment information. In System Settings, click your
Apple Account in the sidebar, then select an item to review and update the information
associated with your account.

Personal Information: Update your name, birthdate, and Memoji or photo associated
with your Apple Account. You can also set up your preferences for communication
from Apple, and see how your data is managed.

Sign-In & Security: Change your Apple Account password, turn on two-factor
authentication, add or remove phone numbers and emails you can use to sign in, and
set up Account Recovery or Legacy Contact. See .

Payment & Shipping: Manage the payment methods affiliated with your
Apple Account, and your shipping address for purchases from the Apple Store.

Use Sign in
with Apple on Mac

Where can I use my Apple Account?

Use Sign in with Apple

help:anchor='mchl12f76694'%20bookID='com.apple.machelp'
https://support.apple.com/102851
help:anchor='mchl12f76694'%20bookID='com.apple.machelp'
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iCloud: Click iCloud, then choose which iCloud features you want to turn on. You can
also turn on iCloud+ features and manage your iCloud storage. When you turn on an
iCloud feature, your content is stored in iCloud, so you can access any content on any
device with iCloud turned on and signed in with the same Apple Account. To learn
more about iCloud, see , as well as 

 and .

Media & Purchases: Manage the accounts linked to Apple Music, Apple Podcasts,
Apple TV, and Apple Books; select purchasing settings; and manage your
subscriptions.

Use the Passwords app. See all your passwords, passkeys, and verification codes in one
place and across all your devices. Sign in to iCloud with the same Apple Account and turn
on Passwords in iCloud settings. See .

See all your devices. See all the devices linked to your Apple Account. You can verify
that Find My [device] is turned on for each one (see ), see the status of iCloud
Backup for an iOS or iPadOS device, or remove a device from your account if you no
longer own it.

Use iCloud with your Mac mini Apps and features
that use iCloud What is iCloud+?

Use passwords on Mac

Find My

https://support.apple.com/guide/icloud/mm203ae070a2/
https://support.apple.com/guide/icloud/mmfc854d9604/icloud
help:anchor='mchl901b1b95'%20bookID='com.apple.Passwords.help'
help:openbook='com.apple.findmy.help'
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Family Sharing. With Family Sharing, you can set up a family group with up to six
members. Then you can share device locations or mark devices as lost in Find My. You
can also manage how your children use their devices by creating Apple Accounts for your
kids and setting Screen Time limits (see ).

With Family Sharing, you can share subscriptions, including Apple TV+, Apple Music,
iCloud+, and more. You can also share purchases from the App Store, Apple TV app,
Apple Books, and iTunes Store. Family members can still use their own iCloud accounts.
You can pay for family purchases with one credit card, while approving your kids’
spending right from your Mac mini. To manage your Family Sharing settings, click Family
in System Settings. To learn more, see the Apple Support article .

Learn more. To learn more about iCloud and Family Sharing, see 
 and .

Use iCloud with your Mac mini
With iCloud, you can keep your information up to date on all your devices, and
collaborate with friends and family. Your Mac mini works seamlessly with your iPhone,
iPad, iPod touch, or Apple Watch when you use iCloud and sign in to each of them with
the same Apple Account.

If you didn’t turn on iCloud when you first set up your Mac, open System Settings, then
click “Sign in to your Apple Account” in the sidebar. After you are signed in, click iCloud,
then turn iCloud features on or off. To learn more, see  and

.

Access your content across devices. With iCloud, you can securely store, edit, and
share your documents, photos, and videos across devices to make sure you’re always up
to date. To get started, see .

Use your Mac mini with other devices. Seamlessly move content between your
Mac mini and other devices using Continuity. Just sign in to your Apple Account, and
whenever your Mac mini and devices are near each other, they work together in
convenient ways. For instance, you can start a task on one device and finish it on another,
use your iPhone as a webcam for your Mac mini, stream your screen to another Mac or
Apple TV with AirPlay, set up your iPad to work side by side with your Mac mini using
Sidecar, and more. See , , and

.

For a list of system requirements for devices that support Continuity, see the
Apple Support article . To
learn more about using Continuity with your Mac mini, see the Apple Support article 

 or go to .

Screen Time on Mac

Set up Family Sharing

Use iCloud with your
Mac mini Manage a Family Sharing group on Mac

Set up iCloud features on Mac
Sign in to iCloud on all your devices

Access your iCloud content on your Mac

Share content between devices Work with multiple devices
Stream content on a larger screen with AirPlay

System requirements for Continuity features on Apple devices
Use

Continuity to connect your Mac, iPhone, iPad, and Apple Watch All your devices

https://support.apple.com/108380
help:anchor='mh5a9bb78c90'%20bookID='com.apple.machelp'
help:anchor='mh36834'%20bookID='com.apple.machelp'
https://support.apple.com/guide/icloud/mmfc0f1e2a/
https://support.apple.com/108046
https://support.apple.com/102418
https://www.apple.com/macos/continuity/
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Do more with iCloud+. iCloud+ is a subscription service that gives you more space to
store your photos, files, and more. You can share your iCloud+ storage plan through
Family Sharing. iCloud+ also includes iCloud Private Relay, HomeKit Secure Video, and
custom email domains for your Mail address on iCloud.com. To learn more about what
iCloud+ has to offer, see .

Access your iCloud content on your Mac
iCloud helps you keep your most important information—like your photos, files, notes,
iCloud Keychain, and more—safe, up to date, and available across all your devices. It’s
built into every Apple device, and everyone gets 5 GB of storage to start. (Purchases you
make from the App Store, Apple TV app, Apple Books, or iTunes Store don’t count toward
your available space.)

So if you have an iPhone, iPad, or iPod touch, just sign in on each device with your
Apple Account, turn on iCloud, and you have everything you need. You can upgrade to
iCloud+ if you need more storage and premium features including iCloud Private Relay,
Hide My Email, Custom Email Domain, and HomeKit Secure Video support.

For system requirements about devices that support iCloud, see the Apple Support
article .

Automatically store your desktop and Documents folder in iCloud Drive. You can
save files in your Documents folder or on your desktop, and they’re automatically
available on iCloud Drive and accessible wherever you are. When working with
iCloud Drive, you have access to files on your Mac mini, on your iPhone or iPad in the
Files app, on the web at , or on a Windows PC in the iCloud for Windows app.
When you make changes to a file on a device or on iCloud Drive, you can see your edits
wherever you view the file.

To get started, open System Settings, click your Apple Account in the sidebar, click
iCloud, then turn on iCloud Drive. To learn more, see 

. Also see the Apple Support article 
.

Store and share photos. Store your photo library in iCloud and see your photos and
videos, as well as the edits you make to them, on all your devices. To get started with
iCloud Photos, go to System Settings, click your Apple Account in the sidebar, click
iCloud, then turn on Photos. 

Use iCloud Shared Photo Library to share photos and videos with up to five other people.
Everyone can make changes—like adding new content, making edits, or adding
comments—to the shared library. Smart suggestions make it easy to add particular
photos from your collection, such as photos featuring a specific person or taken on a

What is iCloud+?

System requirements for iCloud

iCloud.com

Set up and use iCloud Drive on all
your devices Add your Desktop and Documents files
to iCloud Drive

https://support.apple.com/guide/icloud/mmfc854d9604/icloud
https://support.apple.com/118308
https://www.icloud.com/
https://support.apple.com/guide/icloud/set-up-icloud-drive-mm203b05aec8/icloud
https://support.apple.com/109344
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certain date. To get started, go to Photos > Settings, click the Shared Library tab, and
follow the onscreen instructions. To learn more about iCloud Photos, see 

.

Enjoy your purchases anywhere. When you’re signed in to your devices with the same
Apple Account, purchases you’ve made on the App Store, Apple TV app, Apple Books,
and iTunes Store are available at any time, no matter which computer or device you used
to purchase them. So all your music, movies, books, and more are available wherever you
go.

Locate your Mac mini with Find My Mac. If your Mac mini is missing and you have Find
My Mac turned on, you can use  to locate it on a map, lock its screen, and even
erase its data remotely. To turn on Find My Mac, open System Settings, click your
Apple Account in the sidebar, click iCloud, click Show All, then turn on Find My Mac. See
the Apple Support article .

Note: If your Mac mini has multiple user accounts, only one can have Find My Mac turned
on.

Learn more. See the  and .

Use iCloud
Photos on iCloud.com

Find My

If your Mac is lost or stolen

iCloud User Guide What is iCloud?

https://support.apple.com/guide/icloud/photos-on-icloudcom-overview-mmbc402b84/1.0/icloud/1.0
help:openbook='com.apple.findmy.help'
https://support.apple.com/102481
https://support.apple.com/guide/icloud
help:anchor='mh36832'%20bookID='com.apple.machelp'
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Find your way around

Desktop and menu bar on your Mac
The first thing you see on your Mac mini is the desktop. The menu bar runs along the top
of the screen, and the Dock appears at bottom.

Tip: Can’t find the pointer on the screen? To magnify it temporarily, move your finger
rapidly back and forth on the trackpad. Or if you’re using a mouse, slide it back and forth
quickly.

Desktop. The desktop is where you do your work—whether it’s opening and using apps,
working on files, searching your Mac mini or the web with Spotlight, and more. To change
your desktop picture, open System Settings, click Wallpaper in the sidebar, then choose
an option. You can also store files on your desktop and keep them organized using
stacks. To learn more about the desktop, including how to use stacks, see 

.
Get to know

the Mac desktop

help:anchor='mh40612'%20bookID='com.apple.machelp'
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Menu bar. The menu bar runs along the top of the screen. Use the menus on the left side
to choose commands and perform tasks in apps. The menu items change, depending on
which app you’re using. Use the icons on the right side to connect to a Wi-Fi network,
check your Wi-Fi status  , open Control Center  , check your battery charge  ,
search using Spotlight  , and more.

Tip: You can change the icons that appear in the menu bar. See 
.

Apple menu  . The Apple menu contains frequently used items and always appears in
the upper-left corner of the screen. To open it, click the Apple icon  .

App menu. You can have multiple apps and windows open at the same time. The name of
the app that’s active appears in bold to the right of the Apple menu , followed by that
app’s unique menus. If you open a different app or click an open window in a different
app, the name of the app menu changes to that app and the menus in the menu bar
change along with it. If you’re looking for a command in a menu and can’t find it, check
the app menu to see if the app you want is active.

Help menu. Help for your Mac mini is always available in the menu bar. To get help, open
the Finder in the Dock, click the Help menu, and choose macOS Help to open the macOS
User Guide. Or type in the search field and choose a suggestion. To get help for a
specific app, open the app and click Help in the menu bar. See .

Control Center on
your Mac

Use the Mac User Guide
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Tip: You can add widgets from the widget gallery to your desktop, and even bring
over widgets you have on your iPhone—without having to install the corresponding app.
To learn more see .

Learn more. See  and .

Finder on your Mac
Represented by the blue icon with the smiling face, the Finder is the home base for your
Mac. You use it to organize and access almost everything on your Mac, including
documents, images, movies, and any other files you have. To open a Finder window, click

 in the Dock at the bottom of the screen. Force click a file icon to quickly view its
contents, or force click a filename to edit it. See  to learn about force
clicking and other gestures.

Get organized. Your Mac has folders already created for common types of content—
Documents, Pictures, Applications, Music, and more. As you create documents, install
apps, and do other work, you can create new folders to stay organized. To create a new

Manage windows on your Mac

Finder on your Mac The Dock on your Mac

Magic Trackpad
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folder, choose File > New Folder. See .

Sync devices. When you connect a device like an iPhone or iPad, it appears in the Finder
sidebar. Click the device’s name to see options to back up, update, sync, and restore
your device.

The Finder sidebar. The sidebar on the left shows the items you use often or want to
open quickly. To see all your documents stored on iCloud Drive, click the iCloud Drive
folder in the sidebar. To see only the documents that you’re sharing and that are shared
with you, click the Shared folder. To change what’s shown in the sidebar, choose Finder >
Settings.

Change how you view files and folders. Click the pop-up menu button at the top of the
Finder window to change how you view documents and folders. View them as icons , in
a list , in hierarchical columns , or in a gallery . Both Gallery View and Column
view show a large preview of your selected file, so you can visually identify your images,
video clips, and other documents. You can also make quick adjustments, like rotating or
marking up an image. To show the Preview pane options in the Finder, choose View >
Show Preview. To customize what’s shown, choose View > Show Preview Options, then
select the options for your file type.

Tip: To show filenames in Gallery View, press Command-J and select “Show
filename.”

To learn more about the different view options, see 
.

Organize files in folders on Mac

Change how folders are displayed in
the Finder

help:anchor='mh26885'%20bookID='com.apple.machelp'
help:anchor='mchldaafb302'%20bookID='com.apple.machelp'
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Quick Actions. In Gallery View or Column View, click  at the bottom right of the Finder
window for shortcuts to manage and edit files directly in the Finder. You can rotate an
image, annotate or crop an image in Markup, combine images and PDFs into a single file,
trim audio and video files, run shortcuts created with the Shortcuts app, and create
custom actions through Automator workflows (for example, watermarking a file). See

.

Quick Look. Select a file and press the Space bar to open Quick Look. Use the buttons at
the top of the Quick Look window to sign PDFs; trim audio and video files; and mark up,
rotate, and crop images without opening a separate app. To learn more about Quick Look
and markup features, see  and 

.

Tip: You can add alternative image descriptions that can be read by VoiceOver using
Markup in Preview or Quick Look.

Get there faster. The Go menu in the Finder menu bar is a quick way to get to folders
and locations. Instead of using several clicks to navigate to the Utilities folder, choose
Go > Utilities. You can also choose Go > Enclosing Folder to return to the top level of
nested folders. If you know the path to a specific folder, choose Go > Go to Folder, then
type the path. See .

Perform quick actions in the Finder on Mac

View and edit files with Quick Look on Mac Mark up files on
Mac

Go directly to a specific folder

help:anchor='mchl97ff9142'%20bookID='com.apple.machelp'
help:anchor='mh14119'%20bookID='com.apple.machelp'
help:anchor='mchl1fd88863'%20bookID='com.apple.machelp'
help:anchor='mchlp1236'%20bookID='com.apple.machelp'
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The Dock on your Mac
The Dock, at the bottom of the screen, is a convenient place to keep the apps and
documents you use frequently.

Open an app or file. Click an app icon in the Dock, or click the Launchpad icon   in the
Dock to see all the apps on your Mac, then click the app you want. You can also search
for an app using Spotlight  (in the top-right corner of the menu bar), then open the app
directly from your Spotlight search results. Recently opened apps appear in the center
section of the Dock.

Close an app. When you click the red dot in the top-left corner of an open window, the
window closes but the app stays open. Open apps have a black dot beneath them in the
Dock. To close an app, Control-click the app icon in the Dock and click Quit.

Add an item to the Dock. Drag the item and drop it where you want it. Place apps in the
left section of the Dock, and files or folders in the right section.

Remove an item from the Dock. Drag it out of the Dock. The item isn’t removed from
your Mac—just from the Dock.

See everything that’s open on your Mac. Press the Mission Control key  on your
keyboard or swipe with three fingers on your trackpad to open Mission Control. View your
open windows, desktop spaces, full-screen apps, and more, and switch easily between
them. You can also add the Mission Control icon  to the Dock. See 

.

See all open windows in an app. Force click an app in the Dock to view all the app’s
open windows. To Force click, click then press deeper.

See open windows
and spaces in Mission Control on Mac

help:anchor='mh35798'%20bookID='com.apple.machelp'
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Tip: Click Desktop & Dock in System Settings to change the appearance and behavior
of the Dock. Make the Dock larger or smaller, move it to the left or right side of the
screen, set it to hide when you’re not using it, and more.

Learn more. See .

Notification Center on your Mac
Notification Center keeps all of your important information, reminders, and widgets in one
convenient place. Get details about calendar events, stocks, weather, and more—and
catch up on notifications you might have missed (emails, messages, reminders, and
more).

Open Notification Center. Click the date or time at the top right of the screen, or swipe
left from the right edge of the trackpad with two fingers. Scroll down to see more.

Use the Dock on Mac

help:anchor='mh35859'%20bookID='com.apple.machelp'


10/11/24, 4:26 PMMac mini

Page 45 of 137https://apdreview.apple.com/codenames/x/x/en.lproj/static.html

Interact with your notifications. Reply to an email, listen to the latest podcast, or view
details about calendar events. Click the arrow in the top-right corner of a notification to
view options, take action, or get more information.

Set your notification settings. Open System Settings, then click Notifications to select
which notifications you see, including whether you would like to see iPhone notifications
on your Mac. Notifications are sorted by most recent.
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Pause notifications to focus on what you’re doing. When you’re working, having
dinner, or just don’t want to be disturbed, Focus can automatically filter your notifications
so you see only the ones you specify. Focus can pause all notifications or allow only
certain ones to appear, and it can tell contacts that your notifications are silenced using a
status in Messages. To set up Focus, open System Settings, then click Focus in the
sidebar. To turn Focus on or off, click   in the menu bar, then click the Focus section and
choose a Focus.

You can customize a Focus to fit what you’re currently doing, and allow notifications from
certain people or apps, for phone calls or upcoming events, and more. You can also share
your Focus across devices and use Focus filters to hide distracting content in apps like
Calendar and Messages.

Customize your widgets. Click Edit Widgets (at the bottom of Notification Center) to
see the widget gallery and add, remove, or rearrange widgets. If you are signed in to the
same Apple Account on your iPhone and your Mac, you can also add your iPhone widgets
to your desktop without having to install the corresponding apps on your Mac. You can
drag new widgets anywhere on your desktop or in Notification Center. You can also add
third-party widgets from the App Store.

Learn more. See .

Control Center on your Mac
Control Center groups key settings for your Mac into a single place, giving you instant
access to the controls you use the most—like Bluetooth, AirDrop, Screen Mirroring,
Focus, and brightness and volume controls—right from the menu bar. Click  in the
upper-right corner of the screen to open Control Center.

Click for more options. Click a button to see more options. For example, click the Wi-Fi
button  to see your preferred networks, other networks, or to open Wi-Fi Settings. To
return to the main Control Center view, click  again.

Use Notification Center on Mac

help:anchor='mchl2fb1258f'%20bookID='com.apple.machelp'
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Manage your desktop. Use Stage Manager to automatically organize your apps and
windows and quickly switch between them. You can also group apps together to create
workspaces ideal for your workflow. See .

Monitor your mic. When an external mic is connected and in use, a recording indicator
appears at the top of Control Center. This indicator increases security and privacy on
your Mac by letting you know if an app has access to the microphone.

Pin your Control Center favorites. Drag a favorite item from Control Center to the menu
bar to pin it there, so you can easily access it with a single click. To change what appears
in the menu bar, open System Settings, click Control Center, then click the pop-up menu
next to each item and choose “Show in Menu Bar.” You see a preview of where the control
will appear in the menu bar. Some items can’t be added to or removed from Control
Center or the menu bar.

Tip: To quickly remove an item from the menu bar, press and hold the Command key
and drag the item out of the menu bar.

Manage windows on your Mac
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Learn more. See . Also see 
and .

Spotlight on your Mac
Spotlight   is an easy way to find anything on your Mac mini, such as images,
documents, contacts, calendar events, and email messages. You can also use Spotlight
to open apps or perform quick actions, like starting a Focus.

Search for anything. Click   at the top right of the screen then start typing. You can
also press the Spotlight key (F4) on your keyboard. With Live Text, Spotlight can search
for text in images (available in select languages).

Tip: Press Command–Space bar to show or hide the Spotlight search field.

Use Control Center on Mac Share content between devices
Stream content on a larger screen with AirPlay

help:anchor='mchl50f94f8f'%20bookID='com.apple.machelp'
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Open an app. Enter the app name in Spotlight, then press Return.

Perform quick actions. You can quickly do certain tasks with Spotlight, like running a
shortcut, turning on Do Not Disturb, or setting an alarm. Open Spotlight, then search for
the action you want to perform.
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Convert currencies, temperature, and measurements. Enter a currency—like $, €, or ¥
—and an amount, then press Return to get a list of converted values. Or specify a unit of
measure for measurement conversions.

Narrow your search. You can include or exclude specific folders, disks, or types of
information (such as email or messages) from Spotlight searches. Click Spotlight in
System Settings and go to “Search results,” then select or deselect categories you want
to include or exclude from your Spotlight results.

Use Siri Suggestions. Siri Suggestions offer info from Wikipedia articles, web search
results, news, sports, weather, stocks, movies, and other sources when you search with
Spotlight.

If you want Spotlight to search only for items on your Mac mini, open System Settings,
click Spotlight, then deselect Siri Suggestions below “Search results.”

Learn more. See .

Siri on your Mac
Use Siri on your Mac mini to do everyday tasks and find information. For example, you
can schedule meetings, change settings, get answers, send messages, place calls, and
add items to your calendar. If you turn on the “Listen for” option in Siri settings, you can
activate Siri with your voice when you say “Hey Siri” or “Siri,” and immediately speak your
request.

Throughout this guide, you can find examples of how you could use Siri—they look like
this:

Siri: Say to Siri:

“How do I get home from here?”

“How high is Mount Whitney?”

“Create a new grocery list”

“Show me my reminders.”

“What time is it in Paris?”

Note: To use Siri, your Mac must be connected to the internet. Siri may not be available in
all languages or in all areas, and features may vary by area.

Search with Spotlight on Mac

help:anchor='mchlp1008'%20bookID='com.apple.machelp'
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Important: Mac mini doesn’t have a built-in microphone, so you must connect an
external microphone (sold separately) in order to use Siri with your voice. After attaching
your microphone, select it in Sound settings (open System Settings, click Sound, click
Input, then select your microphone). If you use Studio Display with your Mac mini, it has a
built-in microphone that supports Siri.

Turn on Siri. Open System Settings, click Apple Intelligence & Siri in the sidebar, turn on
Siri, then click Enable. If you enabled Siri during setup and you have a Magic Keyboard
with Touch ID, you can also press and hold the Dictation/Siri (F5) key  on your keyboard
to open Siri. You can customize other Siri settings, such as the language and voice to use
and whether to show Siri in the menu bar.

Hey Siri or Siri. If your Mac mini is connected to a Studio Display or an external
microphone, you can say “Hey Siri” or “Siri” to get responses to your requests. Open
System Settings, click Apple Intelligence & Siri, click the pop-up menu next to “Listen
for,” then choose an option. Follow the onscreen instructions to finish setting up “Hey
Siri” or “Siri.”

When this option is on and you turn on “Allow Siri when locked,” you can also use Siri
even if your Mac is locked or in sleep.
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Activate Siri. There are several ways to activate Siri. Click  or  in the menu bar. You
can also press and hold the Dictation/Siri key (F5) on a Magic Keyboard, or use the
keyboard shortcut selected in Siri settings.

Tip: To learn about more ways you can use Siri, ask “What can you do?” at any time,
or see the .

Type to Siri. Type your requests to Siri instead of speaking them. Click Accessibility in
System Settings, then click Siri and turn on “Type to Siri.” If Apple Intelligence is turned
on, you can automatically type Siri requests—just click .

Show captions. Show what Siri says on screen. Open System Settings, click Apple
Intelligence & Siri, then click Siri Responses and turn on “Always show Siri captions.” You
can also turn on “Always show speech” to have Siri transcribe your requests. If Apple
Intelligence is turned on, click Siri Responses and turn on “Always show requests” to
show what Siri says on the screen.

Change the voice. Open System Settings, click Apple Intelligence & Siri, then choose an
option from the Voice menu.

Learn more. See  and .

Apple Intelligence is currently available in beta with Siri and device language set to U.S. English. Apple
Intelligence uses generative models, and outputs may be inaccurate, unexpected, or offensive. Check
important information for accuracy.

Apple Siri website

Use Siri on Mac Get Started with Apple Intelligence

https://www.apple.com/siri/
help:anchor='mchl6b029310'%20bookID='com.apple.machelp'
help:anchor='mchl46361784'%20bookID='com.apple.machelp'
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Customize your Mac

Add a personal touch
Make your Mac mini your own by changing the wallpaper, customizing your desktop, and
more.

Change the wallpaper. Choose what your Mac looks like. Open System Settings, click
Wallpaper, then choose the wallpaper you want. You can select the same image as both
your wallpaper and screensaver or select a different image for each.

Add widgets to your desktop. Keep your favorite apps front and center. Add a Photos
widget to your desktop to see photos from an album or a memory or add a Podcasts
widget to keep your favorite shows on queue. Click the date or time at the top right of the
screen to open Notification Center, then click Add Widgets to open the widget gallery to
add, remove, or rearrange widgets. Drag new widgets anywhere on your desktop or in
Notification Center.
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Make a Memoji. Create a Memoji to represent yourself across apps, including in the login
window on your Mac, as your Apple Account picture, and as your My Card in Contacts.
Open System Settings, click Users & Groups, click the picture next to your login name.
Click Memoji, then click  to select and compose a facial image. See 

 and .
Change your login

picture Create your Memoji in Messages

help:anchor='mtusr002'%20bookID='com.apple.machelp'
help:anchor='ichta6e06677'%20bookID='com.apple.iChat.help'


10/11/24, 4:26 PMMac mini

Page 55 of 137https://apdreview.apple.com/codenames/x/x/en.lproj/static.html

Set up multiple desktops. Use Mission Control to set up multiple spaces to work and
play in. To create a space, enter Mission Control by pressing   on the top row of your
keyboard and click the Add Desktop button  . You can drag windows from one space to
another and add or delete spaces as you work. See .

System Settings on your Mac
In System Settings, you can customize your Mac mini and adjust its settings to suit your
needs. For example, you can add a screen saver that can also become your wallpaper,
manage notifications, change the brightness or resolution with Display Settings, adjust
Accessibility settings, and more. You can also download the latest software update.

To start, click  in the Dock, or choose Apple menu  > System Settings, then click the
setting in the sidebar that you want to adjust. To see all settings in the sidebar, you may
need to scroll down.

Tip: If you’re looking to adjust a particular setting, but aren’t sure where to find it, use
the search field. Results appear in the sidebar as you type.

Work in multiple spaces

help:anchor='mh14112'%20bookID='com.apple.machelp'
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Lock your screen. You can set your Mac mini to turn off the display or start a screen
saver after a period of inactivity. You can also require a password in order to unlock the
screen when you return to your Mac. To set up, go to Lock Screen in System Settings.

Choose a screen saver. Slow-motion screen savers can turn your Mac mini display into a
work of art, both when you’re away from your Mac and as your wallpaper. To set up, go to
Screen Saver in System Settings. If you choose a Landscape, Cityscape, Underwater,
Earth, or Shuffle Aerials screen saver, you can also make it your wallpaper by turning on
“Show as wallpaper.”

Customize Control Center and the menu bar. Choose which settings you want to
appear in Control Center  or in your menu bar. In System Settings, click Control Center
in the sidebar, then choose your options.

Update macOS. In System Settings, click General, then click Software Update to see if
your Mac is running the latest version of macOS software. You can specify options for
automatic software updates.
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iCloud and Family Sharing settings. Sign in to iCloud with your Apple Account on your
Mac mini, manage how your apps use iCloud, and set up and manage Family Sharing. For
more information, see  and .

Learn more. To learn more about System Settings, see 
.

Display settings for your Mac
Match the light in your surroundings. If you have a Studio Display or
Apple Pro Display XDR connected to your Mac mini, it has True Tone technology. True
Tone automatically adapts the color of the display to match the light in your environment
for a more natural viewing experience. Turn True Tone on or off in the Displays settings in
System Settings.

Use a dynamic desktop. When you use a dynamic desktop picture, the desktop picture
automatically changes to match the time of day in your location. Click Wallpaper in
System Settings, then choose a picture for Dynamic Desktop. To have your screen
change based on your time zone, enable Location Services. If Location Services is turned
off, the picture changes based on the time zone specified in Date & Time settings.

Change how items appear on the screen. Change the display resolution to make
everything on the screen bigger, or increase the size of text and icons to make them
easier to see. You can also make the pointer easier to see or quickly locate it with a shake
of your mouse. See .

Stay focused with Dark Mode. You can use a dark color scheme for the desktop, menu
bar, Dock, and all the built-in macOS apps. Your content stands out front and center
while darkened controls and windows recede into the background. See white text on a
black background in apps such as Mail, Contacts, Calendar, and Messages, so it’s easier
on your eyes when you’re working in dark environments.

Apple Account on Mac Use iCloud with your Mac mini

Customize your Mac with System
Settings

Make text and other items on the screen bigger
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Dark Mode is finely tuned for professionals who edit photos and images—colors and fine
details pop against the dark app backgrounds. But it’s also great for anyone who just
wants to focus on their content.

Night Shift. Switch your Mac to warmer colors at night or in low-light conditions to
reduce your exposure to bright blue light. Blue light can make it harder to fall asleep, so
warmer screen colors may help you get a better night’s rest. You can schedule Night Shift
to turn on and off automatically at specific times, or set it to come on from sunset to
sunrise. Open System Settings, click Displays, click the Night Shift button at the bottom,
then set your options. Drag the slider to adjust the color temperature.

Connect a display. You can connect an external display, a projector, or an HDTV to your
Mac. If you’re not sure how many external displays your Mac supports, check your
Technical Specifications. Open System Settings, choose Help > Mac mini Specifications,
then locate Video Support (you may need to scroll). See .

Change the reference mode. Studio Display and Apple Pro Display XDR have several
reference modes that tailor the display’s color, brightness, gamma, and white point to
match the reference requirements for each media type, including several predefined
reference modes for HD and SD video-digital cinema. There are also modes for broader
use cases such as photography, internet and web development, and design and print.
See the Apple Support article .

Learn more. See  and .

Connect a display to Mac mini

Use reference modes with your display

Displays settings on Mac Change Display settings for accessibility

https://support.apple.com/108321
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Screen Time on Mac
Screen Time shows how you spend time on your Mac mini, provides tools to make it easy
to step away during downtime, and lets you monitor what your kids are doing on their
Apple devices.

See how you use your Mac mini. View reports to see how much time you’re spending
with apps and websites during a single day or across a week, find out which apps notify
you the most, and see how often you pick up your device each day. Open System
Settings, choose Screen Time in the sidebar, then click App & Website Activity,
Notifications, or Pickups. You may need to turn on Screen Time before these options
appear.

Set your limits. Set limits to control how much time you spend with specific apps,
categories of apps, and websites. In Screen Time, choose Downtime, turn on Downtime,
then click the Schedule pop-up menu to create a daily schedule or a custom one for
every day of the week.

Manage your kid’s screen time. Parents can configure Screen Time on their Mac—or
iPhone or iPad—and everything is set up for their kids on their devices. You can also set
age-based media ratings for the Music and Books apps. See 

 to learn more.
Set up Screen Time for a

child on Mac
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Don’t miss the important things. Choose which apps or website you always need
access to. In Screen Time, choose Always Allowed, then turn on the apps that you want
to remain available during downtime.

Learn more. See  and 
.

Accessibility on your Mac
Your Mac includes accessibility tools that make Apple features available and easy to use
by anyone. To access these tools, open System Settings, then click Accessibility in the
sidebar. Accessibility settings are grouped into five categories:

Vision: Zoom in on the screen, make the pointer bigger, apply color filters, and more.

Hearing: Show and customize captions on the screen, pair hearing devices, make
Real-Time Text (RTT) calls, get live captions of audio, set accessibility options for
AirPods, and more.

Mobility: Control your Mac and apps using spoken commands, keys on your keyboard,
an onscreen keyboard, facial expressions, or assistive devices.

Speech: Type what you want to say and have it spoken out loud. You can also create a
personal voice.

General: Customize your keyboard shortcuts to quickly turn accessibility features on
or off.

Accessibility features for vision

Use VoiceOver, the built-in screen reader. VoiceOver describes aloud what appears on
the screen and speaks the text in documents, webpages, and windows. Using VoiceOver,
you control your Mac with the keyboard or trackpad gestures. You can also connect a
refreshable braille display to use with VoiceOver.

To turn on VoiceOver, do any of the following:

Press Command-F5. If VoiceOver is on already, pressing the keys turns it off.

Use Siri. Say something like: “Turn VoiceOver on” or “Turn VoiceOver off.”

Choose Apple menu  > System Settings, then click Accessibility in the sidebar (you
may need to scroll down). Click VoiceOver, then turn VoiceOver on or off.

, including how to customize it to fit your needs.

Manage downtime in Screen Time Set up content and privacy
restrictions in Screen Time

Learn more about VoiceOver
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Adjust your View with Zoom. You can zoom in on part or all of the screen. If you have
more than one monitor, you can keep one zoomed in tightly and another at its standard
resolution. To change zoom settings, choose Apple menu  > System Settings, click
Accessibility in the sidebar, then click Zoom.

Zoom in on words with Hover Text. In System Settings, click Accessibility, click Zoom,
then turn on Hover Text at the bottom. Press Command while holding the pointer over the
text, and a window with zoomed text appears on your screen.

Adjust your Mac display colors. You can adjust your Mac display colors using color
filters. To change these settings, go to System Settings, click Accessibility in the sidebar,
click Display, then turn color filters on or off. To quickly turn color filters on or off, press
Option-Command-F5; if your Mac or Magic Keyboard has Touch ID, press Touch ID
quickly three times.

.

Accessibility features for hearing

Add captions in real time. With Live Captions, you can add real-time captions for
conversations, audio, and video. See .

Important: Live Captions is not available in all languages, countries, or regions. The
accuracy of Live Captions may vary and should not be relied upon in high-risk or
emergency situations.

Learn more about accessibility features for vision

Use Live Captions
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Use hearing devices. Pair Made for iPhone (MFi) hearing aids or sound processors
directly to your Mac to stream audio and adjust their settings. To pair devices, choose
Apple menu  > System Settings, click Accessibility in the sidebar, then click Hearing
Devices. See .

Customize your AirPods. Amplify soft sounds and adjust certain frequencies to help
music, movies, phone calls, and podcasts sound more crisp and clear by setting
accessibility options for AirPods. See .

Mask unwanted noise. Mask unwanted environmental noise and minimize distractions
with calming sounds like ocean or rain. To turn on background sounds, choose Apple
menu  > System Settings, click Accessibility in the sidebar, then click Audio and turn on
Background sounds. Choose from a variety of sounds, then drag the slider to increase or
decrease the volume of the background sound.

.

Accessibility features for mobility

Control your Mac with your voice. With Voice Control, you can perform a wide range of
actions with your voice. All audio processing for Voice Control happens on your Mac, so
your personal data is kept private. To turn on Voice Control, choose Apple Menu  >
System Settings, click Accessibility in the sidebar, then click Voice Control.

Important: Mac mini doesn’t have a built-in microphone. To use Voice Control, you must
connect an external microphone (sold separately).

Use hearing devices with your Mac

Set headphone accommodations for AirPods

Learn more about accessibility features for hearing

help:anchor='mchle83953a5'%20bookID='com.apple.machelp'
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Customize your pointer. Customize the outline and fill color of the mouse pointer so it’s
easier to recognize when it moves or changes shape.

Improved keyboard access. An expanded set of keyboard shortcuts allows you to
control everything on your Mac with a keyboard—no mouse or trackpad required.

.

Accessibility features for speech

Have your Mac speak for you. With Live Speech, you can type what you want to say and
have it spoken out loud during phone and FaceTime calls, as well as in-person
conversations. Save commonly used phrases to chime in quickly during a conversation.
You can choose a voice to use or record a Personal Voice. See .

Use Vocal Shortcuts. Set up your Mac to perform an action when you speak a word or
another sound of your choosing. To use Vocal Shortcuts, choose Apple menu  > System
Settings, click Accessibility, go to Speech, then click Vocal Shortcut. See 

.

Important: Mac mini doesn’t have a built-in microphone. To use Voice Control, you must
connect an external microphone (sold separately).

Have Siri listen for atypical speech. If you have an acquired or progressive condition
that affects speech, have Siri recognize a wider range of atypical speech patterns. See

.

.

Learn more. See  and the 
.

Use Mac mini as a server
The most popular server features—File Server, Time Machine Server, and Caching Server
—are a part of macOS, so it’s easy to use your Mac mini as a server. Open System
Settings, choose General, then click Sharing to access one or more of the options below.

File Server: Uses File Sharing to allow users to store and share folders and files on
Mac mini. See .

Time Machine Server: Uses File Sharing to allow users to back up their Mac
computers on your Mac mini using File Sharing. See 

.

Learn more about accessibility features for mobility

Create a Personal Voice

Use Vocal
Shortcuts

Change Siri settings for accessibility

Learn more about accessibility features for speech

Get started with accessibility features on your Mac Apple
Accessibility website

Set up file sharing on Mac

Back up to a shared folder with
Time Machine on Mac
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Caching Server: Uses Content Caching to provide caching of software distributed by
Apple through the internet. See .

Manage windows on your Mac
It’s easy to find yourself with a dozen open apps and one or more windows for each app
open on your desktop. Luckily, there are some efficient ways to see and navigate the
windows you have open. When you want to focus, you can expand one app to fill the
whole screen, choose two apps to share the screen, or lay out a custom workspace.
Automatically organize your apps and windows with Stage Manager to keep your desktop
clutter-free and quickly move between tasks. When you need to find a window that’s
buried, use Mission Control to show all your open windows in a single layer. You can use
multiple desktop spaces to spread out your work on different desktops and easily move
between them.

Use the whole screen. Use full-screen view to focus on one app. In full screen, the menu
bar is hidden until you move the pointer to the top of the screen, or you can choose to
always show the menu bar. To enter or leave full-screen view, move the pointer over the
green button in the top-left corner of the window, then choose Full Screen from the menu
that appears. See .

Change content caching settings on Mac

Use apps in full screen
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Split the screen. Use Split View to work in two app windows side by side. Move the
pointer to the green button in the top-left corner of a window you want to use, click Full
Screen, then choose Right of Screen or Left of Screen to position your window. Click
another window and it automatically fills the other half of the screen. Hold the pointer
over the green button to see the options to switch apps, take the two windows to full
screen, and more. See .

Tile windows. Move and resize windows or arrange windows to fill your screen. Move the
pointer to the green button in the top-left corner of a window you want to use, then
choose how you want to arrange your screen. See .

Tip: If you want to get a clear view of your desktop when you have multiple windows
open, click anywhere on the desktop wallpaper to quickly move any open windows to the
side. Click the desktop wallpaper again to reopen your windows when you’re ready to
resume the task at hand.

Widgets. Place widgets on your desktop from the widget gallery so you have access to
your frequently used apps when you need them. Click the date and time in the menu bar
or Control-click the desktop, then click Edit Widgets to add, remove, or rearrange
widgets. You can drag new widgets anywhere on your desktop or in Notification Center. If
you are signed in with the same Apple Account on your iPhone and your Mac, you can
also add your iPhone widgets to your desktop without having to install the corresponding
apps on your Mac.

Use apps in Split View

Tile windows
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Stage Manager. Automatically organize your apps and windows so your desktop stays
clutter-free. What you want to focus on is front and center with your other windows
arranged on the side and accessible with a single click. Open Control Center, then click
Stage Manager. See .

Mission Control. Quickly move your open windows into a single layer, then click a
window to return to regular view with that window in front and active. If you have
additional desktops (spaces) or have apps in Split View, they appear in a row along the
top of the screen. To enter or leave Mission Control, press   on the top row of your
keyboard, or press Control-Up Arrow. You can also add the Mission Control icon   to the
Dock. See .

When one desktop isn’t enough. Organize your app windows into multiple desktop
spaces, then switch between them as you work. To create a space, enter Mission Control
and click . Use keyboard shortcuts and Mission Control to move between your spaces.
You can drag windows from one space to another and add or delete spaces as you work.
See .

That horizontal traffic light. The red, yellow, and green buttons in the top-left corner of
every window aren’t just for show. Click the red button to close an app window. For some
apps, this quits the app and closes all open windows for the app. For others, it closes the
current window but leaves the app open. The yellow button closes the window
temporarily and puts it in the right side of the Dock. When you want to reopen the
window, click it in the Dock to expand it. And the green button is a quick way to change
your windows to full screen and Split View, and more.

Organize your Mac desktop with Stage Manager

See open windows and spaces in Mission Control

Work in multiple spaces
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Take a screenshot on your Mac
Explore the Screenshot menu to find all the controls you need to take screenshots and
screen recordings. You can also capture your voice during a screen recording. The
optimized workflow lets you take photos and videos of your screen, and then easily
share, edit, or save them.

Access the screenshot controls. Press Command-Shift-5. You can capture the entire
screen, a selected window, or a portion of a window. You can also record the entire
screen or a selected portion of the screen.

Use the icons at the bottom of the screen to capture a selection , record your screen
, and more. Click Options to modify your save location, set a timer before capturing,

set microphone and audio options, or show the pointer. Click Capture or Record to take
the screenshot or video.

After you take a screenshot or video, a thumbnail appears in the corner of the screen.
Drag the thumbnail into a document or folder, swipe to the right to quickly save it, or click
to edit or share it.

Note: You can also open the Screenshot utility from the Other folder in Launchpad, or go
to the Apps > Utilities folder in the Finder.

Mark up your screenshot. Click the thumbnail of your screenshot to use Markup tools
and make annotations. You can also click  to send your marked-up screen to colleagues
or friends—right from the screenshot itself. See .Mark up files on Mac

help:anchor='mchl1fd88863'%20bookID='com.apple.machelp'


10/11/24, 4:26 PMMac mini

Page 68 of 137https://apdreview.apple.com/codenames/x/x/en.lproj/static.html

Learn more. See .Take screenshots or screen recordings on Mac
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Back up, restore, and transfer your data

Transfer your data to your new Mac mini
You can transfer your files and settings from another Mac or PC to your new Mac mini.
The first time you start your new Mac mini, you’re asked if you want to transfer data from
another computer. For more information about transferring data during the setup
process, see . If you want to transfer data from a new computer now,
you can use one of the options below.

Before you begin

Upgrade both your previous computer and new computer to the latest version of the
operating system. For more information about how to update your Mac based on your
current operating system, see . Be sure to use the menu at
the top of the page to choose your current operating system and get the most
accurate instructions.

To transfer your data wirelessly, make sure both computers are connected to same
network.

Transfer data from another Mac

Use Migration Assistant to transfer your data over a wired or wireless network, or by
connecting your old and new computers with an Ethernet cable. On both Macs, open a
Finder window, go to Applications, open the Utilities folder, then double-click Migration
Assistant and follow the onscreen instructions. If you are transferring wirelessly, keep the
computers near each other throughout the migration process. See the Apple Support
article .

Transfer data from a PC

Use Windows Migration Assistant to transfer your data over a wired or wireless network.
See the Apple Support article  to find
the correct version of Migration Assistant for your Windows PC.

Transfer data from a storage device

Connect the storage device to your Mac mini using an appropriate adapter if necessary
(see ). Then, see 

 for next steps.

Set up your Mac mini

Keep your Mac up to date

Transfer to a new Mac with Migration Assistant

Transfer from PC to Mac with Migration Assistant

Use adapters with your Mac mini Transfer your information to Mac from
another computer or device
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Transfer data from a Time Machine backup

If the content on your previous computer’s hard disk was damaged, and you need to
restore it from a Time Machine backup, you can use Migration Assistant to do so. See

.

Learn more. See .

Back up and restore your Mac
It’s important to back up your Mac mini regularly to keep your files safe. You can back up
your apps, accounts, settings, music, photos, movies, and documents using Time
Machine, which is built into your Mac. Time Machine doesn’t back up the macOS
operating system.

Decide where you want to back up your files. Time Machine can back up to an external
storage device connected to your Mac mini, as well as other supported storage devices.
For a list of devices supported by Time Machine, see the Apple Support article 

.

Set up Time Machine. Before you begin, consult the documentation that came with your
storage device, and make sure your Mac mini is on the same Wi-Fi network as your
external storage device, or connect the external storage device to your Mac mini with a
cable, using an appropriate adapter if necessary (see ).
Open System Settings, click General > Time Machine, then click Add Backup Disk. Select
the drive you want to use for backup, and you’re all set.

Restore your files. You can use Time Machine  to restore your files, and choose to
restore only some files or all of them at once. Click the Time Machine icon in the menu
bar, then choose “Browse Time Machine backups.” Select one or more items that you
want to restore (individual folders or your entire disk), then click Restore.

Note: If the Time Machine icon isn’t in the menu bar, choose Apple Menu  > System
Settings, then click Control Center in the sidebar. Click the pop-up menu next to Time
Machine, then choose Show in Menu Bar.

Reinstall macOS. Your operating system files are kept separate from your personal files
in a sealed system disk. However, some actions, like erasing or inadvertently damaging a
disk, require that you restore your Mac mini. You can reinstall macOS and then use Time
Machine to restore your personal files from your backup. With macOS Big Sur and later,
there are several ways to restore your Mac. You may be required to install a newer version
of macOS than what your computer originally came with, or what you were using before
the disk was damaged. To learn more about these options, see 

 and the Apple Support article .

Back up and restore

Transfer your information to Mac from another computer or device

Backup
disks you can use with Time Machine

Use adapters with your Mac mini

Recover all your files from
a Time Machine backup How to reinstall macOS
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Important: Advanced users may want to create a bootable installer to reinstall macOS in
the future. This can be useful if you want to use a specific version of macOS. See the
Apple Support article .

Learn more. See  and 
. Also see the Apple Support article 

.

How to create a bootable installer for macOS

Back up your files with Time Machine Time Machine
troubleshooting on Mac What to do before you sell,
give away, or trade in your Mac
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Share content between devices
There are lots of ways to share content between Apple devices. Use AirDrop to share
files, photos, passwords and more, or copy and paste between devices using Universal
Clipboard.

Share files and more with AirDrop

AirDrop makes it easy to share files with nearby Mac, iPhone, iPad, and iPod touch
devices. The devices don’t need to share the same Apple Account.

Turn on AirDrop. Click  in the menu bar, then click AirDrop . Select “Contacts only”
or “Everyone” to control who can AirDrop content to you.

Send a file from the Finder. Control-click the item you want to send, choose
Share > AirDrop, then select the device you want to send the item to. Or click  in the
Dock, then click AirDrop in the sidebar on the left. When the person you want to send a

Use Mac mini with other devices
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file to appears in the window, drag the file to them from the desktop or another Finder
window. When you send a file to someone, the recipient can choose whether or not to
accept the file.

Send a file from an app. While using an app like Pages or Preview, click  and choose
AirDrop, then select the device you want to send the item to.

Tip: If you don’t see the recipient in the AirDrop window, make sure both devices have
AirDrop and Bluetooth turned on and are within 30 feet (9 meters) of each other. If the
recipient is using an older Mac, try clicking “Don’t see who you’re looking for?”

Receive items using AirDrop. When someone uses AirDrop to send an item to you on
your Mac, you can choose whether to accept and save it. When you see the AirDrop
notification and want the item, click Accept, then choose to save it to your Downloads
folder or an app like Photos. If you’re signed in on several devices with the same iCloud
account, you can easily send an item (for example, a photo from iPhone) from one device
to another, and it’s saved automatically.

Learn more. See  and the
Apple Support article .

Use Handoff on your Mac

With Handoff, you can continue on one device where you left off on another. Start a
FaceTime call on your iPhone, then transfer the call to your Mac mini when you get back
to your desk. Or work on a presentation on your Mac mini, then continue on your iPad.
Handoff works with FaceTime, Safari, Mail, Calendar, Contacts, Maps, Messages, Notes,
Reminders, Keynote, Numbers, and Pages.

Turn on Handoff on your Mac mini. Open System Settings, click General in the sidebar,
click Airdrop & Handoff, then select “Allow Handoff between this Mac and your iCloud
devices.”

Turn on Handoff on your iOS or iPadOS device. Go to Settings > General > Handoff,
then tap to turn on Handoff. If you don’t see the option, your device doesn’t support
Handoff.

Use AirDrop on your Mac to send files to devices near you
Use AirDrop on your Mac
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Turn on Handoff on your Apple Watch. In the Apple Watch app on iPhone, go to
Settings > General, then tap to turn on Enable Handoff.

Hand off actions between devices. For most activities, when your Mac mini and other
devices are near each other, an icon appears in the Dock when that activity can be
handed off. Click the icon to hand off between your devices.

For FaceTime, if you want to hand off a call from your iPhone or iPad to your Mac mini,
click  in the menu bar on your Mac, click Switch, then click Join in the FaceTime
window on your Mac. To hand off a FaceTime call from your Mac mini to your iPhone or
iPad, tap  in the upper left of your iPhone or iPad, tap Switch, then tap Switch again.

Learn more. See .

Copy and paste between devices

Copy content from one device, and paste it to another nearby device within a short
period of time. The contents of your Clipboard are sent over Wi-Fi and made available to
all Mac, iPhone, iPad, and iPod touch devices that are signed in to the same
Apple Account and have Handoff, Wi-Fi, and Bluetooth turned on.

Pick up where you left off with Handoff

help:anchor='mchl732d3c0a'%20bookID='com.apple.machelp'
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Learn more. See .

Use your iPhone to take photos on your Mac

Continuity Camera on your Mac lets you use your iPhone as an additional camera for your
Mac. You can use your iPhone camera to take photos to insert them into documents or
save them to your Mac.

Insert an image or scan. Use the camera on your iPhone, iPad, or iPod touch to scan
documents or take a picture of something nearby. The image appears instantly on your
Mac. In an app like Mail, Notes, or Messages, select where you want the image to go,
choose File (or Insert) > Import From iPhone or iPad, choose Take Photo or Scan
Documents, then take the photo or scan the image on your iOS or iPadOS device. Tap
Use Photo or Keep Scan. You can also tap Retake if you want to try again.

In an app such as Pages, select where you want the image to be inserted, then Control-
click, choose “Import image,” and take the photo. You might need to select your device
before taking the photo.

Copy and paste between devices from your Mac

help:anchor='mchl70368996'%20bookID='com.apple.machelp'
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Note: To take a scan on your iOS or iPadOS device, drag the frame until what you want to
show is in the frame, tap Keep Scan, then tap Save. Tap Retake to rescan the content.

The photo or scan appears where you want it in your document.

Learn more. See  and 
.

Stream content on a larger screen with AirPlay
Use AirPlay to stream whatever’s on your Mac mini on the big screen—or use AirPlay to
send content to your Mac from an iPhone, iPad, or even another Mac. You can mirror the
Mac mini screen on your high-resolution TV screen or use the high-resolution TV as a
second display. To do so, connect your TV to Apple TV and make sure Apple TV is on the
same Wi-Fi network as your Mac mini. You can also play web videos directly on your
high-resolution TV without showing what’s on your desktop—handy when you want to
play a movie but keep your work private.

Send content to your Mac from other devices. Watch videos, listen to music, and more
on your Mac as they’re being played on your other devices. Mirror your iPhone or iPad on
your Mac or extend its display by using your Mac as a secondary display for apps that
support it, such as Keynote and Photos. Use your Mac as an AirPlay 2 speaker to stream
music or podcasts to your Mac, or use it as a secondary speaker for multiroom audio.
Your Mac works with any Apple device, and it’s even easier to connect if the devices
share the same Apple Account.

Mirror your desktop using Screen Mirroring. Click  in the menu bar, click , then
choose your Apple TV. When AirPlay is active, the icon turns blue.

Note: If your Mac supports AirPlay screen mirroring, you see an AirPlay status icon in the
menu bar when an Apple TV is on the same network as your Mac. See 

.

Play web videos without showing your desktop. When you find a web video with an
AirPlay icon  , click the icon, then select your Apple TV.

Apple TV is sold separately at  or your local Apple Store.

Tip: If the image doesn’t fit your high-resolution TV screen when you mirror the
screen, adjust the desktop size for the best picture. Click   in the video, then choose an
option under Match Desktop Size To.

Use your iPhone as a webcam Insert photos and scans with
Continuity Camera on Mac

Stream audio and
video from your Mac with AirPlay

apple.com

help:anchor='mchl77879b8a'%20bookID='com.apple.machelp'
help:anchor='mchl9aebdc99'%20bookID='com.apple.machelp'
help:anchor='mchld7e543a0'%20bookID='com.apple.machelp'
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10/11/24, 4:26 PMMac mini

Page 77 of 137https://apdreview.apple.com/codenames/x/x/en.lproj/static.html

Learn more. To learn more about AirPlay, see 
. To learn more about using a second display with your Mac mini, see 

. To troubleshoot, see the Apple Support article 
.

Work with multiple devices
Your Mac works with your other Apple devices. Continuity lets you unlock powerful
capabilities when you use Mac, iPad, iPhone, or Apple Watch together.

Before you begin. Make sure your Mac mini and iOS or iPadOS device have Wi-Fi and
Bluetooth turned on and are signed in to the same Apple Account.

Use your iPhone with your Mac

Add iPhone widgets to your desktop. Put your iPhone widgets directly on your Mac
desktop. Use the Widget Gallery to select iPhone widgets for your Mac or drop widgets
from Notification Center onto your desktop. To open the Widget Gallery, Control-click the
desktop, then select Edit Widgets.

Use your iPhone as a webcam. Continuity Camera on your Mac lets you use your iPhone
as an additional camera for your Mac. You can use your iPhone camera to make video
calls. After you set up Continuity Camera, your Mac can automatically switch to using
iPhone as a camera when it is in range. You can also use a wired connection if you prefer.
See  and .

Note: To use Continuity Camera as a webcam requires an iPhone XR or newer. To use
Continuity Camera to share photos, you need an iPhone or iPod touch with iOS 12 (or
later) or an iPad with iPadOS 13.1 (or later) installed.

Use your iPhone microphone. With Continuity Camera, you can use your iPhone as a
microphone for your Mac. Use the Video menu in FaceTime to select your iPhone during a
call, or use app settings to switch to your iPhone’s microphone during video calls. You
can also use Audio settings in System Settings to select your iPhone as your system
microphone.

Use iPhone apps on Mac. Many of your favorite iPhone and iPad apps work on your Mac.
See .

Phone calls and text messages on Mac. With a Wi-Fi connection, you can take calls—
and make them—right from your Mac mini. You can also receive and send text messages.

Use AirPlay to stream what’s on your Mac
to an HDTV Connect
a display to Mac mini If screen mirroring
or streaming isn’t working on your AirPlay-compatible device

Choose an external camera Use your iPhone as a webcam

Use iPhone and iPad apps on Mac with Apple silicon

help:anchor='mh40624'%20bookID='com.apple.machelp'
https://support.apple.com/102587
help:anchor='mchl034033f4'%20bookID='com.apple.machelp'
help:anchor='mchl77879b8a'%20bookID='com.apple.machelp'
help:anchor='fird2c7092da'%20bookID='com.apple.AppStore.help'
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On your iPhone, go to Settings > Phone and enable Wi-Fi calling. Then, on your Mac,
open FaceTime. Go to Settings, choose General, then click “Calls from iPhone.” See 

.

Use your iPhone as a Hotspot. Lost your Wi-Fi connection? With Instant Hotspot, you
can use the Personal Hotspot on your iPhone or iPad to connect your Mac mini to the
internet instantly—no password required. See 

.

Click  in the menu bar, then click   next to your iPhone or iPad in the list (if you
don’t see the list, click Other Networks). The Wi-Fi icon in the toolbar changes to 
. You don’t need to do anything on your device—Mac mini connects automatically. When
you’re not using the hotspot, your Mac mini disconnects to save battery life.

Tip: If you’re asked for a password, make sure your devices are set up correctly. See
the Apple Support article 

.

Use your iPad with your Mac

Get even more out of Mac mini by using it with your iPad. Sidecar lets you use your iPad
as a second display for your Mac — giving you extra space to spread your work out and
draw in your favorite Mac apps with Apple Pencil. With Universal Control, you can also
control your iPad with your Mac keyboard and mouse or trackpad, making it easy to move
content between iPadOS and macOS. Plus you can quickly markup screenshots, PDFs,
and more.

Use your iPad as another display for your Mac. With Sidecar, you can use your iPad
wirelessly within 32 feet (ten meters) of your Mac, or you can connect your iPad to your
Mac with a cable to keep it charged.

Set up Sidecar. Choose Apple menu   > System Settings, click Displays, then choose
your iPad from the Add Display pop-up menu.

Connect and disconnect from your iPad. To connect your iPad, click , click , then
click the name of your iPad. To disconnect from your iPad, click  in Control Center or
tap   in the sidebar of your iPad.

Set Sidecar settings. Open System Settings, click Displays, then click the name of your
iPad. You can then specify Sidecar settings for your iPad, such as whether it is the main
display or mirrors your Mac, whether it shows the sidebar and where it is located, and if
you can double-tap with Apple Pencil to access tools.

Note: If you haven’t set up your iPad, you don’t see these options in Display settings.

Set
up your iPhone and Mac for phone calls

Use an iPhone or iPad to connect to the
Internet

Use Instant Hotspot to connect to your Personal Hotspot
without entering a password

help:anchor='fctm264ce831'%20bookID='com.apple.FaceTime.help'
help:anchor='mchl7594e36f'%20bookID='com.apple.machelp'
https://support.apple.com/109321
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Use Apple Pencil. Precisely draw and create in your favorite pro apps. Just drag the
window from your Mac to your iPad and start using Apple Pencil. Or use Apple Pencil to
mark up PDFs, screenshots, and images. To learn more, see 

 and the Apple Support article 
.

Note: Pressure and tilt for Apple Pencil only work in apps with advanced stylus support.

Extend or mirror your desktop. When you connect your iPad, it automatically becomes
an extension of your Mac desktop, so you can drag your apps and documents between
your Mac and iPad. To show your Mac screen on both devices (mirror the display), move
your mouse over the Sidecar button  in Control Center, click the right arrow that
appears above the button, then select Mirror Built-in Retina Display. To extend your
desktop again, open the menu and choose Use As Separate Display.

Take advantage of sidebar shortcuts. Use the sidebar on your iPad to quickly reach
commonly used buttons and controls. Tap the buttons to undo actions, use keyboard
shortcuts, and display or hide the menu bar, Dock, and keyboard.

Tip: For quick access to the Sidecar options, you can set Display settings  to
always appear in the menu bar. Go to System Settings > Control Center, then use the
pop-up menu next to Displays to select whether to show the Displays icon in the menu
bar all the time or only when active. When Sidecar is on and your iPad is connected, the
Display icon in the menu bar changes to .

Use a single keyboard and mouse or trackpad to control multiple devices. With
Universal Control, you can use a single keyboard and a mouse or trackpad to control
multiple devices. When you move the pointer to the edge of your Mac mini screen, the
pointer moves to your iPad or another Mac, so you can work across up to three devices.

Before you begin. To use Universal Control on your Mac, make sure each device has
Bluetooth turned on and is connected to Wi-Fi. Also make sure Handoff is turned on in
General settings on your Mac mini and in Settings > General > AirPlay & Handoff on your
iPad. You must also be signed in with the same Apple Account on both devices, and have
two-factor authentication turned on. When these settings are correct, you can use
Control Center to connect your devices. On your Mac, click Control Center in the menu
bar, click Screen Mirroring, then choose a device below Link Keyboard and Mouse.

Move between screens. On your Mac, use your mouse or trackpad to move the pointer
to the right or left edge of the screen closest to your iPad, pause, then move the pointer
slightly past the edge of the screen. When a border appears at the edge of the iPad
screen, continue moving the pointer to the iPad screen.

Insert sketches with
Continuity Sketch Use Markup on your iPhone, iPad, or
iPod touch

help:anchor='mchl74e7c6df'%20bookID='com.apple.machelp'
https://support.apple.com/119875


10/11/24, 4:26 PMMac mini

Page 80 of 137https://apdreview.apple.com/codenames/x/x/en.lproj/static.html

Drag and drop. Select the text, image, or other object you want to move, then drag it to
where you want it on your other device. For example, you can drag a sketch you drew
with Apple Pencil from your iPad to the Keynote app on your Mac mini. You can also copy
something on one device and paste it on the other.

Share a keyboard. When the pointer is in a document or anywhere that you can enter
text and the insertion point is blinking, begin typing.

Learn more. See  and 
.

Use your iPad as a second display for your Mac Use a keyboard
and mouse or trackpad across devices with Universal Control on Mac

help:anchor='mchlf3c6f7ae'%20bookID='com.apple.machelp'
help:anchor='mchl412faecf'%20bookID='com.apple.machelp'
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Work with apps on your Mac mini
Your Mac mini comes with a wide range of apps already installed, so you can stay
connected with friends and family, be productive and creative, enjoy hours of
entertainment, surf the web, and much more.

Note: Some macOS apps are not available in every region or language.

View apps. To quickly see all the apps on your Mac, click   in the Dock.

Tip: Every app that comes with your Mac includes built-in help. To learn how to use
an app, go to the app you want to use, then choose Help > [App] Help in the menu bar.
See .

Open an app. You can have multiple apps open at the same time on your Mac, and leave
them open. This is especially useful for apps you return to frequently, such as Safari or
Mail. To open an app, do one of the following:

Use the Dock: Click the app icon in the Dock. If an app isn’t in the Dock, click  in the
Dock, then click the app. For more information on the Dock, like how to add
frequently used apps, see .

Apps

Use the Mac User Guide

The Dock on your Mac
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Use the Finder: Click  in the Dock, click Applications in the sidebar of the Finder
window, then double-click the app you want to open.

Tip: To quickly open an app, use Spotlight search. Press Command-Space bar, type
the app’s name in the search field, then press Return. See .

Close an app. Closing an app closes the window, but the app remains open even if there
are no active windows (a small dot below the app’s icon in the Dock indicates that the
app is open). To close an app, click  in the top-left corner of the app’s window.

Quit an app. If you use an app only occasionally, you may want to quit the app when
you’re done using it, especially if the app uses significant energy. To quit an app, choose
[App Name] > Quit [App Name] in the menu bar. For example, choose Preview > Quit
Preview.

Note: If an app doesn’t quit as expected or it’s unresponsive, you can force quit the app,
though you may lose unsaved changes. To force quit an app, press Command + Option +
Esc or choose Apple menu  > Force Quit. Select the app in the dialog that appears, then
click Force Quit.

Search with Spotlight

help:anchor='mchlp1008'%20bookID='com.apple.machelp'
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Stay connected with FaceTime, Mail, and Messages
Your Mac mini offers built-in apps that empower you to stay connected with friends and
family, near and far. Click the link in the table to learn more about FaceTime, Mail, and
Messages.

FaceTime

Make and receive video and
audio calls in the FaceTime app
on your Mac.

Mail

Send and receive email
messages and manage your
mail accounts.

Messages

Send and receive iMessages
and SMS/MMS messages with
the Messages app on Mac.

FaceTime

With FaceTime, you can make video and audio calls to family and friends, and connect
with up to 32 people in a Group FaceTime call. Not available to talk? Send a message or
set a reminder to call back, right in the app.

Note: FaceTime requires an external camera and microphone. Accessories are sold
separately at , your local Apple Store, or other resellers.

Get started with FaceTime Get started with Mail Get started with Messages

apple.com

https://apple.com/
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Sign in to FaceTime. Before you can make and receive video and audio calls, you need to
sign in to FaceTime. Enter your Apple Account email or phone number and your password
in the FaceTime window, then click Sign In. Don’t remember if you have an Apple
Account? If you have an iPhone, go to Settings, then tap your name. The email you used
for your Apple Account appears under your name at the top.

Siri: Say something like: “Make a FaceTime call to Sharon.”

Make a FaceTime call. Connect a camera and microphone to your Mac mini to make
FaceTime video calls. Click New FaceTime, enter a name, phone number, or email address
for the person you want to call, then click . If it’s not convenient to make a video call,
you can make an audio-only call: click , then choose FaceTime Audio.

Tip: Add up to 32 people to a group call. To make a unique link to share with a group,
click Create Link at the top-left corner in the FaceTime window. Copy the link to your
clipboard or share directly with friends in Messages or Mail, or add the link to a Calendar
event to schedule a call for later. You can now use a link to join FaceTime calls on non-
Apple devices.
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Accept or decline calls. When you receive a FaceTime call, click Accept to join with
video. To answer with audio only, click  next to Accept, then choose Answer as Audio. If
you can’t take a call, click Decline—or click  next to Decline to send a message or get a
reminder to call back later.

Choose your background. With macOS Sequoia or later, you can choose a virtual
background to express yourself or just hide the laundry behind you. To change your
background, go to the FaceTime app, click  in the menu bar, then select Background.
Click the Background to choose one of the beautiful built-in backgrounds, or customize
your background further by uploading one of your own or choosing from Photos.

Learn more. See the .

Mail

Read, write, and send emails from all your accounts—iCloud, Gmail, Exchange, Yahoo,
Outlook, and more—all in one place.

FaceTime User Guide

help:openbook='com.apple.FaceTime.help'
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Set up your email accounts. Tired of signing in to multiple websites to check your email
accounts? Set up Mail with all your accounts so you can see all your emails in one place.
Choose Mail > Add Account.

Send or schedule an email. To start a new email, click  in the Mail toolbar. Type the
recipient’s email address, enter a subject, and type your message in the space below.
When finished with your draft, click  to send it or  to schedule a time.

Send photos or other files. You can include photos, documents, and more when you
write email messages. To add files, click , locate your file, then select it. To add photos,
click  and select the photos you’d like to send.

Siri: Say something like: “Email Laura about the trip.”
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Find emails fast. You can quickly find emails by searching using your own words. In Mail,
click  in the top-right corner and type a word like “photo.” Mail shows emails where the
word appears, and a menu allows you to refine your search by categories like sender or
subject.

Tip: Stay organized by setting up custom rules to filter emails—for example, you can
block email from a specific sender by moving their emails directly to the Trash. To add a
rule, click Mail > Settings > Rules, then click Add Rule.

Learn more. See the .Mail User Guide

help:openbook='com.apple.Mail.help'
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Messages

Stay connected by sending and receiving messages and media right from your Mac.
Search makes it easy to find messages in a snap, and you can pin your favorite
conversations to the top so it’s quick to get in touch with the people you chat with the
most.

Message anyone, on any device. When you sign in to your Apple Account, you can use
iMessage to exchange unlimited messages with anyone with an Apple device. If you have
an iPhone, you can also relay SMS/MMS messages from your iPhone to your Mac. Click 
to start a conversation.

See the Apple Support article 
for more information about different types of messages.

Siri: Say something like: “Message Mom that I’ll be late.”

Add photos, stickers, and more. In a conversation, click , then choose Photos,
Stickers, #images, or Message Effects to add fun media and effects to add to your
message. Or easily share files, photos, and videos by dragging them into Messages.

What is the difference between iMessage and SMS/MMS?

https://support.apple.com/104972
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Tip: With macOS Sequoia, you can now schedule a message to send at a specified
time. Click , choose Send Later, then choose a date and time to send your message.

Find the right message. Find the message you’re looking for quickly by typing a
person’s name or keywords into the search field. Combine search filters to further narrow
your search. Your results are organized by category, such as conversations, messages,
and photos.

Keep favorite conversations at the top. Pin your favorite conversations to the top of the
messages list by dragging them to the top. New messages, Tapbacks, and typing
indicators appear above a pinned conversation. When there are unread messages in a
group conversation, the most recent participants appear around the pinned conversation.

Learn more. See the .Messages User Guide

help:openbook='com.apple.MobileSMS.help'
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Be productive with Calendar, Notes, Reminders, and
Shortcuts
Your Mac mini offers built-in apps that empower you to work more efficiently, get
organized, and manage your day with ease. Click the link in the table to learn how to
harness the productivity power of Calendar, Notes, Reminders, and Shortcuts.

Calendar

Keep track of your schedule by adding multiple
calendars and managing them all in one place.

Notes

Notes is your go-to place for notes of all kinds
anytime, anywhere. Include checklists, audio
recordings, images, and more.

Reminders

Create, share, and organize your to-do lists with
the Reminders app on your Mac.

Shortcuts

Create custom automations in your favorite
apps to help you accomplish everyday tasks
using Siri or with a click.

Calendar

Add calendars, create events and new reminders, complete your to-dos, and share your
calendar to keep others informed in the Calendar app on Mac.

Get started with Calendar
Get started with Notes

Get started with Reminders
Get started with Shortcuts
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Add multiple accounts. With Calendar, you can add multiple accounts—iCloud, Google,
Microsoft Exchange, and more—and manage all your events from one place. Open the
Calendar app, choose Calendar > Add Account, then follow the onscreen instructions.

Add calendars. You can create separate calendars to keep track of different schedules.
For example, keep all of your work meetings in one calendar and your children’s school
events in another. Choose File > New Calendar. If you have multiple accounts, choose the
account for the new calendar. The new calendar appears in the sidebar. To change the
name or color of the calendar, Control-click it, then choose Get Info.

Tip: You can choose to show all your calendars—or just a few. Click  to see a list of
all your calendars and scheduled reminders, then select or deselect a calendar’s
checkbox to show or hide it.

Create events and reminders. To create a new event or reminder, click   or double-
click a day and time in the calendar window, then choose Event or Reminder. You can also
include additional information, like location, a URL, or notes. After creating an event or
reminder, you can edit it by double-clicking it. Reminders created in Calendar also sync
back to the Reminders app.

Siri: Say something like: “Set up a meeting with Mark at nine in the morning.”
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Share a calendar with others. iCloud makes it easy to share calendars. Control-click a
calendar under your iCloud account in the sidebar, then choose Share Calendar. Enter the
email of the person you want to share with.

Learn more. See the .

Notes

With many formatting options to help you stay organized, plus powerful search tools, and
collaboration features, the Notes app is your go-to place to jot down notes of all kinds.
You can add checklists, images, audio recordings, and more; collaborate on notes with
others; and even solve expressions by typing an equals sign.

Calendar User Guide

help:openbook='com.apple.iCal.help'
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Create or edit a note. Click  in the Notes toolbar to create a new note. To change an
existing note, click anywhere in the note and begin making changes.

Format and add content to notes. You can add checklists, tables, images, links, audio
recordings, and more to your notes. Click  to format text—for example, add a list,
make a collapsible subheading or heading, or highlight text. Click  to record audio, 
to add a photo, or  to add a link to another app.

Collaborate on a note. You can send an invitation to collaborate on a list in Messages or
Mail, or share the link. Click  in the toolbar, choose Collaborate or Send Copy from the
pop-up menu, then select Messages, Mail, or Copy Link. After you’ve invited others to
join, you can track activity and manage collaboration by clicking .
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Solve math problems. Crunch numbers, evaluate expressions, and assign variables—
right from Notes. To define a variable, type a word or a letter, followed by the equal sign
and the variable’s value. To use a variable, the variable has to precede any expression it’s
used in. To solve an expression, enter the expression followed by the equal sign.

Tip: Find the note you want when you need it. Click  in the toolbar to show the
search field, type what you’re looking for, then press Return. You can also search a single
note by pressing Command-F, then typing a word or a phrase. Any matches appear
highlighted in your note.

Learn more. See the .

Reminders

Consolidate your to-do lists in one place in the Reminders app. Add new tasks, track your
progress, and share the load with others. Keep track of your reminders on other Apple
devices when you use iCloud.

Notes User Guide

help:openbook='com.apple.Notes.help'
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Create a reminder list. You can create a list for each of your projects to help keep your
to-dos organized. With iCloud reminders, you can also create automatically categorized
Grocery Lists or custom Smart Lists based on rules and filters you identify. To create a
list, choose File > New List, then choose from Standard, Groceries, or Smart List.

Note: Grocery lists are not available in all languages.

Add or edit a reminder. Click the space below the last item on a list or click  in the top
right to add a new reminder. You can add notes, tags, a date, or a location to your
reminder by clicking .

Siri: Say something like: “Remind me to stop at the grocery store when I leave here.”

Collaborate on a list. Share the load by sending an invitation to collaborate on a list.
Click , then choose Messages, Mail, or Invite with Link. If you share in Messages,
everyone on the thread is automatically added to the list. After you’ve invited others to
join, you can track activity, manage collaboration, and even assign reminders.
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Tip: If you’re the organizer of a Family Sharing group, you can create a Family Grocery
List that is automatically shared with members in your Family Sharing group. See 

.

See what’s coming up. Keep on top of upcoming reminders and make sure you never
miss a beat. Scheduled reminders show up in the Calendar app, and in the Today and
Scheduled Smart Lists in Reminders. To add a date to a reminder, hold the pointer over
the reminder, click , choose On a Day, then select the date you want to be reminded.

Learn more. See the .

Shortcuts

Use Shortcuts to do everyday tasks using Siri or with a simple click. You can create
custom shortcuts, or choose from hundreds of built-in actions—for example, get
directions to the next event in your calendar, send an ETA, or play a favorite playlist.

Create a
Family Grocery List

Reminders User Guide

help:anchor='remn175e6897'%20bookID='com.apple.reminders.help'
help:openbook='com.apple.reminders.help'
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Browse the Gallery to find shortcuts. Starter shortcuts for a range of common tasks
are grouped in collections. The shortcuts you create, and ready-made shortcuts you
choose or edit, are shown in All Shortcuts in the sidebar.

Create a shortcut from the gallery. Choose a shortcut from the Gallery to add it to your
shortcuts. For example, in the Quick Shortcuts collection, click Play Playlist, then click

. Choose the playlist you want that shortcut to play, then click Add Shortcut.

Create a custom shortcut. You can also create your own shortcuts. While viewing All
Shortcuts, click  in the toolbar, then drag actions from the list on the right to the
shortcut editor on the left to produce the results you want. Actions are building blocks of
a shortcut, like steps in a task. Shortcuts also provides “next action” suggestions to help
you complete your shortcut. For ideas, see .Ideas for custom shortcuts

help:anchor='apdb272b27ec'%20bookID='com.apple.shortcuts.remote.help'
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Shortcuts to your shortcuts. Using Siri or a widget to run a shortcut is the quickest way
to get something done. You can also add shortcuts to the Finder and the Services Menu,
or pin them in the Shortcuts Menu Bar. Double-click a shortcut, click , then choose
options under Use a Quick Action.

Siri: Say something like: “Text last image.”

Learn more. See the .

Get creative with Photos, Freeform, and iMovie on Mac
Your Mac mini offers built-in apps that empower you to create. Click the link in the table
to learn more about getting started with Freeform, Photos, and iMovie.

Shortcuts User Guide

help:openbook='com.apple.shortcuts.remote.help'
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Photos

Browse, edit, and share your
photos and videos from all of
your devices with Photos.

Freeform

Freeform provides a flexible
canvas for you to pull all the
pieces together—solo or with
others.

iMovie

Create stunning home-videos
and trailers with easy-to-use
tools in iMovie.

Photos

In the Photos app, you can view, edit, and share your photos and videos from all your
devices. Use intelligent, personalized features that help you find, enjoy, and share your
best shots and memories.

All your photos on all your devices. With iCloud Photos, you can browse, search, and
share all the photos and videos from all your devices that are signed in to the same
Apple Account. When you use your iPhone to take a photo, it automatically appears on all
of your devices. And if you edit photos, those edits appear on all of your devices, too.

To get started, see .

Get started with Photos
Get started with Freeform

Get started with iMovie

Use iCloud Photos

help:anchor='phtf5e48489c'%20bookID='com.apple.Photos.help'
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Import photos. You can import photos from an iPhone, iPad, camera, or files. With
Photos open on your Mac, connect your device or camera and turn it on. If you’re
importing from a camera, set it to download photos. Choose File > Import, select the
device in the sidebar, click the photos you want to import, then click Import [X] Selected.

Tip: To select multiple photos, Command-click to select some photos in a list or
Shift-click to select a range of photos in a list.

Edit photos like a pro. Create standout photos with powerful but easy-to-use editing
tools. Double-click a photo, then use the buttons in the toolbar to make quick
improvements, like rotating or automatically adjusting the color and contrast. For more
powerful editing tools, click Edit in the toolbar, then use Smart Sliders to get professional
results.

Browse collections and enjoy your memories. Collections automatically organize your
library by topics like Days, Trips, People, and Memories. To see a personalized collection
of photos and videos featuring a significant person, place, or event from your Photos
library, click Memories in the Photos sidebar. The collection of photos and videos have
been set to music, so you can watch them like a movie. To share with friends and family,
double-click the memory, click , then choose how you want to share.
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Learn more. See the .

Freeform

Use the Freeform app to sketch out a project, create a trip itinerary, build a storyboard,
design a mood board, and more. Whether you’re working solo or collaborating on a
shared vision, Freeform provides a flexible canvas for brainstorming.

Create a board. Click  in the toolbar to create a new board, then start adding content.
You can add almost anything to a board—for example, click  to add a sticky note,  to
add text, or  to add a photo or link. Keep clicking and adding to build your board.
Format and move items around until your board matches your ideas—the bigger, the
better.

Collaborate in Freeform. You can send an invitation to collaborate in Messages or Mail,
or copy and share the link. Click  in the toolbar, choose Collaborate, then select
Messages, Mail, or Copy Link. If you share in Messages, everyone on the thread is invited
to the board.

Tell a story with your board. Scenes let you organize and present your board section by
section in the order you choose. Click , click , then click Add Scene.

Start on your Mac, finish on your iPad. Sign in to the same Apple Account on all your
Apple devices so you can access your boards, anywhere, anytime. To use iCloud with
Freeform, choose  Apple menu > System Settings, click [your name] in the sidebar, click
iCloud, click Show All, then turn on Freeform.

Photos User Guide

help:openbook='com.apple.Photos.help'
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Learn more. See the .

iMovie

iMovie lets you turn your home videos into beautiful movies and Hollywood-style trailers
that you can share with a few quick clicks.

Create a movie or Hollywood-style trailer. To get started with a project, click  in the
Projects pane, then choose Movie or Trailer. When you choose Trailer, select a template,
then click Create.

Add media from your photo library. Photos and video clips in your Photos library are
automatically available for use in iMovie. In a project, select your photo library in the
iMovie sidebar, choose the photo or clip you want to use to see a preview in the viewer,
then drag it to the timeline to add it to your project. iMovie creates a new library and
event for you.

You can also import video from your iPhone or iPad, from a camera, or from media files
already on your Mac.

Record video in iMovie. Connect a camera and microphone to your Mac to record video
in iMovie. Select an event in the sidebar, click Import in the toolbar, select the camera,
then click the Record button to start and stop recording.

Freeform User Guide

help:openbook='com.apple.freeform.help'
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Tip: Shooting video with a handheld device can produce shaky results, but you can
stabilize the video so the playback is smoother. Select the clip in the timeline, click ,
then click Stabilize Shaky Video.

Learn more. See  and .

Watch and listen with Music, Podcasts, and TV
Your Mac mini offers built-in apps that provide hours of entertainment and sync with your
other Apple devices when you’re signed in to the same Apple Account.

Music

Listen to your favorite tunes
from your personal library or
subscribe to Apple Music to
listen ad-free to over 100
million songs and 30,000
playlists.

TV

Watch all your movies and TV
shows in the Apple TV app.
Buy or rent movies and TV
shows or subscribe to
additional channels or
services.

Podcasts

Listen to your favorite shows—
from big names to independent
publishers, discover your next
favorite, or subscribe with
Podcasts.

Music

The Apple Music app makes it easy to organize and enjoy your iTunes Store purchases,
songs, and albums. In addition to your personal library, you can also subscribe to access
the Apple Music catalog, which lets you listen to millions of songs on demand and
immerse yourself in lossless and Spatial Audio.

If you haven’t already, sign in to your Apple Account to get started.

iMovie User Guide iMovie Support

Get started with Music Get started with TV
Get started with Podcasts

help:openbook='com.apple.iMovie.help'
https://support.apple.com/imovie



